
Kiva
User Manual

v9.0



Thank You For Choosing Ross
You've made a great choice. We expect you will be very happy with your purchase of Ross Technology.
Our mission is to:
1. Provide a Superior Customer Experience

• offer the best product quality and support

2. Make Cool Practical Technology
• develop great products that customers love

Ross has become well known for the Ross Video Code of Ethics. It guides our interactions and empowers
our employees. I hope you enjoy reading it below.
If anything at all with your Ross experience does not live up to your expectations be sure to reach out
to us at solutions@rossvideo.com.

David Ross
CEO, Ross Video
dross@rossvideo.com

Ross Video Code of Ethics
Any company is the sum total of the people that make things happen. At Ross, our employees are a
special group. Our employees truly care about doing a great job and delivering a high quality customer
experience every day. This code of ethics hangs on the wall of all Ross Video locations to guide our
behavior:
1. We will always act in our customers' best interest.
2. We will do our best to understand our customers' requirements.
3. We will not ship crap.
4. We will be great to work with.
5. We will do something extra for our customers, as an apology, when something big goes wrong and

it's our fault.
6. We will keep our promises.
7. We will treat the competition with respect.
8. We will cooperate with and help other friendly companies.
9. We will go above and beyond in times of crisis. If there's no one to authorize the required action in

times of company or customer crisis - dowhat you know in your heart is right. (Youmay rent helicopters
if necessary.)
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• Release Date: May, 2024.
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Express, Tria News, Kiva, and any related marks are trademarks or registered trademarks of Ross Video
Limited. All other trademarks are the property of their respective companies. PATENTS ISSUED and
PENDING. All rights reserved. No part of this publication may be reproduced, stored in a retrieval system,
or transmitted in any form or by any means, mechanical, photocopying, recording or otherwise, without
the prior written permission of Ross Video. While every precaution has been taken in the preparation
of this document, Ross Video assumes no responsibility for errors or omissions. Neither is any liability
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are registered trademarks of Oracle and/or its affiliates. Other names may be trademarks of their
respective owners.
TechSmith® and Camtasia® are either registered marks or marks of TechSmith Corporation in the U.S.
and/or other countries.
AMD, Ryzen™, and combinations thereof are trademarks of Advanced Micro Devices, Inc.
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FCC Compliance and User Information
The following information has been provided to clarify FCC requirements for operation of this device.
These requirements are found in the FCC rules for radio frequency devices, Part 15.

Compliance
This equipment has been tested and found to comply with the limits for a Class A digital device pursuant
to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful
interference when the equipment is operated in a commercial environment. This equipment generates,
uses, and can radiate radio frequency energy and, if not installed and used in accordance with the
instruction manual, may cause harmful interference to radio communications. Operation of this
equipment in a residential area is likely to cause harmful interference in which case the user will be
required to correct the interference at his or her own expense.

Important - Modifications & Shielded Cables
Changes or modifications to this product not authorized by Ross® Video Limited could void the FCC
Compliance and negate authority to operate the product.
This product was tested for FCC compliance under conditions that included the use of Ross® peripheral
devices and Ross® shielded cables and connectors between system components. It is important that
Ross® peripheral devices are used, and shielded cables and connectors are used between system
components to reduce the possibility of causing interference to radios, television sets, and other electronic
devices. Ross® peripheral devices and the properly shielded cables and connectors can be obtained
directly from Ross®, or through a Ross® authorized dealer.

EMC Notices

Canada
This Class “ A ” digital apparatus complies with Canadian ICES-003.
Cet appareil numérique de la classe “ A ” est conforme a la norme NMB-003 du Canada.

Korea — Class A Statement
이 기기는 업무용 환경에서 사용할 목적으로 적합성평가를 받은 기기로서 가정용 환경에서 사용하는 경우 전파간섭
의 우려가 있습니다.
This device has been evaluated for conformity for use in a business environment. When used in a home
environment, there is a danger of interference.
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Europe
This equipment is in compliance with the essential requirements and other relevant provisions of CE
Directive 93/68/EEC.

Australia
This equipment has been tested toAS/NZS CISPR 22:2009 +A1:2010 and found to comply with the limits
for a Class A Digital device.

International
Important: This is a Class A product. In domestic environments, this product may cause radio interference, in which case the
user may have to take adequate measures.

Safety and First Aid
Ross® Abekas® equipment is designed to the highest standards of quality and reliability. However, no
matter how these systems are designed, operators and maintenance personnel can be exposed to electrical
shock hazard when protective covers are removed for maintenance or the installation of options. With
this caution in mind, each operator and engineer must observe all safety regulations, and have a clear
understanding of first aid procedures related to electrical hazards.

Safety and Compliance Certifications

Power Information
To ensure safe operation and to guard against potential shock or risk of fire, ensure your AC power
source for the system is within the required voltage range and frequency.

Operating Environment
The optimum operating environment is within the following ranges:
• Recommended Operating Temperature:
• Recommended Operating Humidity: 20% to 80% non-condensing

Note: High temperature/humidity should be avoided at all times.

Safety Information

Important Safety Notices
This system complies with safety standard . To ensure safe option and to guard against potential shock
hazard or risk of fire, the following must be fulfilled:
• This system features auto-ranging power supplies. Ensure that your power source is within the correct

range of voltage and frequency, as required by the system.
• Each chassis in this system must be electrically grounded by connecting the input power cord(s) to

a correctly wired and grounded power outlet.

Warning: Completely disconnect all input AC power cords from the chassis before removing the top cover from the chassis.
Failure to do so will expose dangerous electric currents and voltages. Physical contact with these electric currents and voltages
is extremely dangerous and may result in severe physical injury or death! Only qualified service personnel should remove the
top cover from the chassis.
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Warning Hazardous Voltages: Modules marked with this symbol may be removed while the system is operating (powered).
After removing amodule, beware of dangerous electric currents and voltages that are exposed on themodule receptacle connector
inside the chassis. Please keep fingers, tools, and foreign metal objects away from the exposed receptacle connector while the
chassis has input AC power applied. Physical contact with these electric currents and voltages is extremely dangerous and may
result in severe physical injury or death! Only qualified service personnel should remove these modules.

Environmental Information
The equipment that you purchased required the extraction and use of natural resources for its
production. It may contain hazardous substances that could impact health and the environment.
To avoid the potential release of those substances into the environment and to diminish the need for
the extraction of natural resources, Ross Video encourages you to use the appropriate take-back systems.
These systems will reuse or recycle most of the materials from your end-of-life equipment in an
environmentally friendly and health conscious manner.
The crossed-out wheeled bin symbol invites you to use these systems.

If you need more information on the collection, reuse, and recycling systems, please contact your local
or regional waste administration.
You can also contact Ross Video for more information on the environmental performances of our
products.

Company Address
Ross Video Limited — 8 John Street Iroquois, Ontario, Canada, K0E 1K0
Ross Video Incorporated — P.O. Box 880, Ogdensburg, New York, USA, 13669-0880

(+1)613-652-4886General Business Office:

(+1)613-652-4425Fax:

1-844-652-0645Toll Free Technical Support (North America):

+800 1005 0100Toll Free Technical Support (International):

(+1)613-652-4886Technical Support:

(+1)613-349-0006After Hours Emergency:

techsupport@rossvideo.comE-Mail (Support):

solutions@rossvideo.comE-Mail (General):

www.rossvideo.comWebsite

Technical Support
At Ross Video, we take pride in the quality of our products, but if a problem does occur, help is as close
as the nearest telephone.
Our 24-Hour Hot Line service ensures you have access to technical expertise around the clock. After-sales
service and technical support are provided directly by Ross Video personnel. During business hours
(eastern standard time), technical support personnel are available by telephone. Outside of normal
business hours and on weekends, a direct emergency technical support phone line is available. If the
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technical support personnel who is on call does not answer this line immediately, a voice message can
be left and the call will be returned shortly. Our Technical support staff are available to react to any
problem and to do whatever is necessary to ensure customer satisfaction.
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Required Equipment
To set up and operate your server you will need the following equipment:
• Computer monitor with minimum 1920×1080 resolution.
• HD-SDI video monitor to view the internal quad-split output (1-3 depending on the number of channels

in your server)
A standard USB keyboard (QWERTY) and mouse are provided with your server.
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Getting Started
The server consists of a 3RU computer with advanced video processing, storage, and streaming
capabilities. The server runs a standard Microsoft® Windows® operating system with the pre-installed
Abekas® software applications for interacting with the video processing hardware.

Power On/Off
The system powers on with the single power button located at the front of the chassis. When the power
button is pressed the system will boot up and launch Windows®.

Warning: Even with the system powered off, hazardous voltages are present inside the chassis. Disconnect both the primary
and secondary power supplied before opening up the chassis.

Windows® Login
The server comes with the Microsoft® Windows® operating system and all the required software
pre-installed.
Refer to the Windows® help system for information on changing the password.

Note: Once you have logged in to the system, the video channels and serial control are all active. If you are using an external serial controller,
that controller can now be used to control the video channels (including loading and playing clips).

Software
The server comes pre-installed with all the software needed for operation and setup.
• Kiva Presenter — provides you a shot-box style interface with program and preview Media Player

control with independent audio program and preview.
• Kiva Import — allows you to import media files into the server.
• Kiva Config — allows you to configure the hardware of the server.
• AsRun Log Report Creator— generates a file of the AsRun Log that contains all media playout from

all video channels of the video server.

Important: Do not install any additional third party software applications onto the video server. Third party software applications
that did not come pre-installed on your video server can place demands on system resources thatmay negatively impact real-time
audio/video processing resulting in performance degradation in recording and/or playback. Install third party application at
your own risk.
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Server Configuration
The Kiva Config application allows you to configure various aspects of the hardware in your server.
The number of channels and inputs and outputs you have depend on the hardware installed in your
server.

Important: Not all settings are available on all servers or require a option to be purchased or installed.

Channel Setup
The hardware channels consists of a single, fixed VKA (video + alpha + audio) media player with a single
recording input per board. Up to two boards (channel pairs) can be installed into the server.

To Configure the Hardware Channels
The number of hardware channels on your server depends on the configuration you purchased.
1. Launch the Kiva Config application.

You may be prompted to allow the program to make changes on the computer, click Yes.

2. Click the Channels tab.

Note: Your selections may appear different, depending on the number of channels you have.

3. The configuration is fixed to video plus key.
4. Select the default alpha (key) output that is used on a video plus key channel transport when no

alpha channel is present in the clip or no clip is loaded.
• Output BLACK on key output — the key (alpha) channel outputs a full frame of internally

generated black.
• Output WHITE on key output — the key (alpha) channel outputs a full frame of internally

generated white. Use this selection if the output is going to a switcher as an auto-select key. The
full-frame white alpha will force the entire video image onscreen.

5. Click Apply.

Video Formats
Select the video format that the server is operating in, and the source of the reference signal.

To Configure the Video Format
The server can only operate in one video format at a time. All Media Players will play and record in the
same format.

Note: Not all video resolutions and frequencies are compatible. Some selections will be grayed out if they are not compatible.
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1. Launch the Kiva Config application.
You may be prompted to allow the program to make changes on the computer, click Yes.

2. Click the Video tab.

3. In the Video Reference Frequency area, select the frequency you want the server to operate in.
4. In the Video Resolution area, select the video resolution you want the server to operate in.

Note: The available resolutions depend on the frequency you have selected.

5. In the Video Reference Source area, select the type of input reference signal that the server is using.
This is the video signal that is connected to the REF IN HD-BNC on the back of the server.

Note: You should only use Free Run when the server is not receiving video from, or outputting video to, another device.

Important: If you select Tri-Level External Reference or Bi-Level External Reference with no valid reference signal
coming into the server, you will get corrupt video on all outputs.

6. In the Horizontal Phase area, select a timing offset for the video output relative to the reference
timing.

7. Click Restart Kiva. A confirmation dialog box is displayed.
8. Click Restart Kiva to restart the server application and services with the new setting.
9. Click OK when the restart has completed to dismiss the window.

Video Router Setup
You can connect the server to an external router and control the sources feeding the server.

Note: The router must support the Evertz® Quartz or Probel SW-P-08 protocol.

To Connect to a Video Router
You can change which destinations are coming into the server from the router, as well as which sources
on the router are routed to those destinations.
1. Launch the Kiva Config application.

You may be prompted to allow the program to make changes on the computer, click Yes.
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2. Click the Video Router tab.

3. In the Router Protocol area, select the protocol you want to use to communicate with the router.
• Probel SW-P-08 — select this option of your router uses the Snell Advanced Media® SW-P-08

protocol.
• Quartz — select this option if your router uses the Evertz® Quartz protocol.

4. In the Router Levels field, select the number of levels that the router is using.
5. In the Router IP Address field, enter the IP address of the router you want to control.
6. In the Router Port Number field, enter the port on the router you want to connect to.
7. Click Connect to Router to connect to the router.
8. In the Video Router Destinations area, select which destinations on the router are connected to

each video channel input on the server. This is the physical connection from one BNC to the other.
9. In theChangeRouter Sources area you can change which sources are being routed to the destinations

that are assigned to each video channel input on the server.
10. Click Apply.

Audio Setup
You can select the number of audio channels to record, which sources audio will use, and which audio
channel to monitor from the analog audio out headphone jack. The number of AES digital audio inputs
and outputs depends on the model of server you purchased. You can select the number of audio tracks
to record, which sources audio will use, and which audio channel to monitor from the analog audio out
headphone jack.

To Configure the Audio Setup
Select the number of channels to record and which channels are sent to the headphones jacks.
1. Launch the Kiva Config application.

You may be prompted to allow the program to make changes on the computer, click Yes.

2. Click the Audio tab.
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3. In the Audio Tracks area, select the number of audio channels to record.
• 2 track audio — record two channels of audio.
• 4 track audio — record four channels of audio.
• 8 track audio — record eight channels of audio.
• 14 track audio — (software option) record fourteen channels of audio.

4. In the Audio Tracks in an ISO Clip area, select the number of audio channels to record per input
channel.

5. In the Audio Muting Policy area, select how the audio output (AES, embedded, and analog audio
out) is muted during playback.
• Mute everything except 100% play speed and JOG STEP — audio is muted at all play speeds

except 1× (100%) and during single-frame jogging.
• Mute everything except 100% play speed. Mute JOG STEP — audio is muted at all play speeds

except 1× (100%).
• Mute when speed is not in the range 85% through 115% of play speed — audio is muted at all

play speeds except in the range of 85% to 115% play speed.
• Mute when playback speed exceeds 200% play speed. — audio is muted only when play speed

exceeds 2× (200%).

6. In the Analog Audio Monitor area, select the Media Player audio that you want to monitor on the
analog audio output headphone jack. Only audio channels 1 and 2 are available on the analog audio
output port.

Note: Each board has a dedicated audio monitor output.

7. Click Apply.

Audio Router Setup
There are two integrated audio routers built into the server. An input router that sends audio from an
audio input to any Media Player, and an output router that sends the audio from a Media Player to any
audio output. The number of audio inputs and outputs depends on the options you have installed in
your server.

Kiva User Manual (v9.0) — Server Configuration • 15



Audio sources and destinations include embedded audio and AES audio on the TASCAM® AES-59 DB25
ports on the back of the server.

To Configure the Audio Router
The Audio Input Router tab allows you to set the audio channel that get recorded on the server and the
Audio Output Router tab allows you to set which audio channels are played from the server.
1. Launch the Kiva Config application.

You may be prompted to allow the program to make changes on the computer, click Yes.

2. Click the Audio Router tab.

Tip: If the audio routing on an input or output has been changed, a dot is shown next to the name on the tab.

3. Click the Audio Input Router tab.

4. Click on the tab for the record channel that you want to route audio channel to.
5. In the ChX XXXRecorder Track 1 row, select the source channel input (ChX XXX Input) and the audio

track (Track #) from the input that you want to record on track 1 of the clip.
6. Repeat this step for all of the remaining recorder channels.

Tip: Click NORMANIZE ALL ChX XXX Input Routes to reset all the input audio tracks to their default recorder track assignment.
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7. Click the Audio Output Router tab.

8. Click on the tab for the channel output into which you want to route audio channels.
9. In the ChX XXX Audio Output Track 1 row, select the source channel player (ChX XXX Player) and

the audio track (Track#) from the player that you want to route to track 1 of the output video stream.
10. Repeat this step for all of the remaining output audio channels you want to assign a source to.

Tip: Click NORMANIZE ALL ChX XXX Output Routes to reset all the player audio track to their default output track assignment.

11. Click Apply.

Timecode Setup
The selected timecode information that is recorded with the video can be overlaid on the output video
stream of the server. This can be time of day linear timecode (LTC) coming into the server, or the
embedded ancillary timecode (ATC) in the video stream being recorded.

Important: When you turn the timecode overlay on, it is shown over the image on the video output.

To Configure the Timecode
The selected timecode information that is recorded with the video can be overlayed on the output video
stream of the server.

Note: The timecode overlay is only on the video output and will not appear in the recorded video.

1. Launch the Kiva Config application.
You may be prompted to allow the program to make changes on the computer, click Yes.

2. Click the Timecode tab.

Kiva User Manual (v9.0) — Server Configuration • 17



3. In the Timecode Input Source area, select the timecode source for each channel.
• Time of Day LTC In — the LTC signal coming into the server.
• ATC In — the embedded digital timecode in the video source.

4. In the Replace ATC Output with Timecode Remain area, select the video channels that you want
the normal count-up ATC timecode to be replaced with the count-down (time-remaining) ATC
timecode.

Tip: This is useful when you want to display count-down timecode in downstream devices that can decode and display ATC timecode.

5. In the Replace Viewer Timecode with Time Reaming area, select the video channels that you want
the normal timecode to be replaced with the count-down (time-remaining) timecode.

6. In the Timecode Overlay on Video Output area, select whether the timecode is displayed on the
video output for each channel.
• Off — the timecode is not shown on the video output stream.
• On in EE and Record — the timecode is only shown when in EE mode or when the channel is

recording.
• Always On — the timecode is always shown on the video output stream.

7. In the Timecode Overlay Position And Size area, use the Left/Right and Top/Bottom sliders to
position the timecode overlay on the background video source, and use the H Small/H Large and V
Small/ V Large sliders to adjust the size of the timecode text.

8. In the Clips Beyond 24-Hour Timecode area, select whether the server can record a clip that is
longer than 24 hours in length.

Note: External devices controlling the server over VDCP or AMP will not support timecode over 24 hours. You will not be able to seek
beyond the 24 hour point as the timecode restarts again.

9. Click Apply.

Channel Label Setup
You can assign a custom name to each output of a Media Player.
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Labels are shown at the top of each Media Player in Kiva Presenter and, optionally, on each quadrant
in the Quad Viewer HD-BNC output.

Note: The Quad Viewer Label Overlay option must be enabled for the labels to be visible on the Quad Viewer output.

To Assign Labels to Channels
Labels can be shown on the Media Player to help identify each channel.
1. Launch the Kiva Config application.

You may be prompted to allow the program to make changes on the computer, click Yes.

2. Click the Labels tab.

3. Enter a new label name for each Media Player as required.

Tip: Leave the label name field blank to remove the channel label from the Media Player and Quad Viewer.

4. Click Apply.

Quad Viewer Setup
The Quad Viewer HD-BNC output displays the Quad Viewer.

Note: When Kiva is operating in 1080p, the Quad Viewer output is 1080i.

Quad Viewer Display
The Quad Viewer HD-BNC outputs show the audio and video output of each Media Player in the server.

• Channel, audio meters, and status are shown along the top of each quadrant.
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• Clip name and timecode are shown along the bottom of each quadrant.
• The position of the channel label can be adjusted.
• The opacity of all the overlay text can be adjusted.

To Configure the Quad Viewer
Select what is displayed on the Quad Viewer output and adjust the transparency of the text overlay on
the Quad Viewer output.
1. Launch the Kiva Config application.

You may be prompted to allow the program to make changes on the computer, click Yes.

2. Click the Quad Viewer tab.

3. In the Output Display area, select Quad Viewer (Quad Split Display).
4. In theClip InformationOverlay area, adjust the opacity of the clip information text and background

of the text. These overlays are shown in the corners of each Quad Viewer quadrant.

Tip: Select one of the Overlay Presets to quickly set both the text and background opacity.

• Use the Text Opacity slider to adjust the transparency of the overlay text.
• Use the Background Opacity slider to adjust the transparency of the background behind the

overlay text.

5. In the Channel Label Overlay area, select the opacity, position, and size of the channel information
text.
• Opacity — select the transparency of the label. Select Off to disable the channel label overlay.
• Position — select the position for the label in the quadrant.
• Height — select the size of the label.

6. Click Apply.

TSL Tally Setup
The server can receive TSL messages from a downstream device to tally the channels on the server.
For example, when a production switcher takes the Channel 1 source from the server on-air, the switcher
sends a signal back to the server telling it that Channel 1 is on-air and should be tallied.
The tally status is shown using the color of the background of the Channel Label.
• Gray — the channel is not on program or preview.
• Red — the channel is on program.
• Green — the channel is on preview.
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• Amber — the channel is being recorded by a downstream device.

Note: TSL tally colors are set by how the protocol was implemented in the source device and may not be as listed above. Check with the
device that is sending the TSL information to the server for information on how the protocol was implemented.

To Configure the TSL Tally Input
Tally information sent to the server over ethernet using the TSL protocol is used to show red and green
tallies (as well as gray and amber) on the channel labels. You will need the IP address and port of the
device sending the tally information, as well as the screen mapping.
1. Launch the Kiva Config application.

You may be prompted to allow the program to make changes on the computer, click Yes.

2. Click the Tally tab.

3. In the Server Address field enter the IP address of the device that is sending the TSL tally information.
4. In the Server Port field enter the port number on the device that the server is listening to.
5. In the Server Connection Type area, select the type of ethernet communication you want to use.

• UDP — select if you connect to the tally system using the UDP protocol.
• TCP Server — select if you connect to the tally system as a server using the TCP protocol.
• TCP Client — select if the connect to the tally system as a client using the TCP protocol.

6. In the Tally Protocol area, select the TSL protocol the tally system is using.
• TSL UMD V5.0 — select if the tally server is using the TSL tally protocol v5.0.
• TSL UMD V3.1 — select if the tally server is using the TSL tally protocol v3.1.

7. Set up the tally interface as required:

SettingsProtocol

TSL v5.0

Select which tally screen you want to assign to each channel transport.Tally Screen Number

Select a tally id for each channel transport.Tally Index Number
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SettingsProtocol

TSL v3.1

Select which indicator is lit when a Media Player is tallied on preview.Assign Preview Tally

Select the color to use when a Media Player is tallied on preview.Assign Preview Tally Color

Enter the tally ID that is assigned on the tally server to the input on the server.

Tip: Refer to the device that you are receiving the tally information from for the ID that is assigned
to the video input that is connected to the output of each channel on the server.

Tally Index Number

8. Click Apply.
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Import
The Kiva Import file import utility converts all imported media files to the current video output format
that the server is operating in.
For example, if the server is currently operating in the 1080i 59.94Hz video format, then all imported
media files are converted to 1080i 59.94Hz video format. Media files are converted even if they are in
a different video format.

Supported Media Files for Hardware Import
Note: Some file formats require a third-party codec to be installed on the server.

Plug-inCodecFile Type

none needed(DV25) DVCPRODV

none needed(DV25) DVCPROMOV

none neededAnimation

none neededH.264

none neededJPEG

none neededJPEG 2000

none neededMPEG-E Video

none neededNONE (No Compression)

none neededProRes

none neededPNG

Avid® DNxHD1Avid® DNxHD

• 1 This codec from Avid® enables import of DNxHD essence within MOV files. AvidCodecsLESetup.zip

Supported Import Transcoding
The Software Transcoder in Kiva Import uses FFmpeg™ for the decoding operation.
In the table below, the legend column identifies which elements of the media file are supported.
• E — Encoding supported
• D — Decoding supported
• V/A — Video codec (V) / Audio Codec (A)
• I — Intra frame-only codec
• L — Lossy compression
• S — Lossless compression

Video+Audio and Video Only Media Files
Codec DescriptionCodecLegend

Uncompressed 4:2:2 10-bit012v.DVI..

4X Technologies Movie4xm.DV.L.

Autodesk® RLEaasc.DV..S

Apple® Intermediate Codecaic.DVIL.

Alias/Wavefront PIX imagealias_pixEDVI.S
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Codec DescriptionCodecLegend

AMV VideoamvEDVIL.

EA® DeluxePaintanm.DV.L.

ASCII/ANSI artansi.DV.L.

APNG (Animated Portable Network Graphics) imageapngEDV..S

ASUS V1asv1EDVIL.

ASUS V2asv2EDVIL.

Auravision AURAaura.DVIL.

Auravision Aura 2aura2.DVIL.

Avid® AVI Codecavrn.DV...

Avid® 1:1 10-bit RGB PackeravrpEDVI..

AVS (Audio Video Standard) videoavs.DV.L.

Avid®Meridien UncompressedavuiEDVI..

Uncompressed packed MS 4:4:4:4ayuvEDVI..

Bethesda® VID videobethsoftvid.DV.L.

Brute Force & Ignorancebfi.DV.L.

Bink® videobinkvideo.DV.L.

Binary textbintext.DVI..

BMP (Windows® and OS/2 bitmap)bmpEDVI.S

Discworld® II BMV videobmv_video.DV..S

BRender PIX imagebrender_pix.DVI.S

Interplay® C93c93.DV.L.

Chinese AVS (Audio Video Standard) (AVS1-P2, JiZhun profile)cavs.DV.L.

CD Graphics videocdgraphics.DV.L.

Commodore CDXL videocdxl.DVIL.

GoPro® Cineform® HDcfhd.DV.L.

CinepakcinepakEDV.L.

Cirrus Logic® AccuPakcljrEDVIL.

GV Grass Valley® Canopus® Lossless Codeccllc.DVI.S

Electronic Arts CMV video (decoders: eacmv)cmv.DV.L.

CPiA video formatcpia.DV...

CamStudio™ (decoders: camstudio)cscd.DV..S

Creative YUV (CYUV)cyuv.DVIL.

Microsoft® DirectDraw Surface image decoderdds.DVILS

DreamForge Chronomaster DFAdfa.DV.L.
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Codec DescriptionCodecLegend

BBC® Dirac (encoders: vc2)diracEDV.LS

Avid® VC3/DNxHDdnxhdEDVIL.

SMPTE® DPX (Digital Picture Exchange) imagedpxEDVI.S

Delphine Software International CIN videodsicinvideo.DV.L.

DV (Digital Video)dvvideoEDVIL.

Feeble Files/ScummVM DXAdxa.DV..S

ExKode Dxtorydxtory.DVI.S

Resolume DXVdxv.DVIL.

Square Enix® Escape 124escape124.DV.L.

Square Enix® Escape 130escape130.DV.L.

Lucasfilm® OpenEXR™ imageexr.DVILS

FFmpeg™ video codec #1ffv1EDV..S

Huffyuv FFmpeg™ variantffvhuffEDVI.S

Mirillis® FICfic.DV.L.

Adobe® Flash Screen Video v1flashsvEDV..S

Adobe® Flash Screen Video v2flashsv2EDV.L.

Autodesk® Animator Flic videoflic.DV..S

Adobe® FLV / Sorenson Spark® / Sorenson Media® H.263 (Flash
Video) (decoders: flv) (encoders: flv)

flv1EDV.L.

Beepa® Frapsfraps.DV..S

Forward Uncompressedfrwu.DVI.S

LogMeIn G2M (GoToMeeting)g2m.DV.L.

GIF (Graphics Interchange Format)gifEDV..S

H.261h261EDV.L.

H.263 / H.263-1996, H.263+ / H.263-1998 / H.263 version 2h263EDV.L.

Intel® H.263h263i.DV.L.

H.263+ / H.263-1998 / H.263 version 2h263pEDV.L.

H.264 / AVC / MPEG-4 AVC / MPEG-4 part 10 (encoders:
h264_nvenc nvenc nvenc_h264)

h264EDV.LS

VIDVOX Hap decoderhap.DVIL.

DivX® HEVC/H.264 (High Efficiency Video Coding) (encoders:
nvenc_hevc hevc_nvenc)

hevcEDV.L.

HNM 4 videohnm4video.DV.L.

GV Grass Valley® Canopus® HQ/HQAhq_hqa.DVIL.

GV Grass Valley® Canopus® HQXhqx.DVIL.
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Codec DescriptionCodecLegend

HuffyuvhuffyuvEDVI.S

ZeniMax® id® QUAKE® II CIN video (decoders: idcinvideo)idcin.DV.L.

iCEDraw textidf.DVI..

IFF ACBM / ANIM / EDEP / ILBM / PBM / RGB8 / RGBN (decoders:
iff)

iff_ilbm.DV.L.

Intel® Indeo 2indeo2.DV.L.

Intel® Indeo 3indeo3.DV.L.

Intel® Indeo Video Interactive 4indeo4.DV.L.

Intel® Indeo Video Interactive 5indeo5.DV.L.

Interplay®MVE videointerplayvideo.DV.L.

JPEG 2000jpeg2000EDVILS

JPEG-LSjpeglsEDVILS

Bitmap Brothers JV videojv.DVIL.

Kega Game Videokgv1.DV.L.

Karl Morton's video codeckmvc.DV.L.

Lagarith losslesslagarith.DVI.S

LOCOloco.DVI.S

Matrox® Uncompressed SDm101.DVI.S

Electronic Arts Madcow Video (decoders: eamad)mad.DV.L.

MagicYUV videomagicyuv.DVI.S

Sony® Playstation®MEDC (Motion EDCoder)mdec.DVIL.

Microsoft®Mimicmimic.DV.L.

Motion JPEGmjpegEDVIL.

Apple®MJPEG-Bmjpegb.DVIL.

American Laser Games MM Videommvideo.DV.L.

Motion Pixels videomotionpixels.DV.L.

MPEG-1 videompeg1videoEDV.L.

MPEG-2 video (decoders: mpeg2video mpegvideo)mpeg2videoEDV.L.

MPEG-4 part 2mpeg4EDV.L.

Microsoft® ATC Screenmsa1.DV.L.

MPEG-4 part 2 Microsoft® variant version 1msmpeg4v1.DV.L.

MPEG-4 part 2 Microsoft® variant version 2msmpeg4v2EDV.L.

MPEG-4 part 2 Microsoft® variant version 3msmpeg4v3EDV.L.

Microsoft® RLEmsrle.DV..S
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Codec DescriptionCodecLegend

Microsoft® Screen 1mss1.DV.L.

Microsoft®Windows®Media Video V9 Screenmss2.DVIL.

Microsoft® Video 1msvideo1EDV.L.

LCL (LossLess Codec Library) MSZHmszh.DVI.S

Microsoft® Expression Encoder Screenmts2.DV.L.

Silicon Graphics®Motion Video Compressor 1mvc1.DVIL.

Silicon Graphics®Motion Video Compressor 2mvc2.DVIL.

MOBOTIX®MxPEG videomxpeg.DV.L.

Nupplevideo/RTJPEGnuv.DV.L.

Amazing Studio Packed Animation File (PAF) Videopaf_video.DV.L.

PAM (Portable AnyMap) imagepamEDVI.S

PBM (Portable BitMap) imagepbmEDVI.S

ZSoft PC Paintbrush PCX imagepcxEDVI.S

PGM (Portable GrayMap) imagepgmEDVI.S

PGMYUV (Portable GrayMap YUV) imagepgmyuvEDVI.S

PCPaint/Pictor Paintpictor.DVIL.

PNG (Portable Network Graphics) imagepngEDV..S

PPM (Portable PixelMap) imageppmEDVI.S

Apple® ProRes (iCodec Pro) (decoders: prores prores_lgpl)
(encoders: prores prores_aw prores_ks)

proresEDVIL.

VTech® V.Flash PTX imageptx.DVIL.

Apple® QuickDraw®qdraw.DVI.S

Q-Team QPEGqpeg.DV.L.

AJA® KONA 10-bit RGB Codecr10kEDVI.S

Uncompressed RGB 10-bitr210EDVI.S

raw videorawvideoEDVI.S

RL2 videorl2.DVIL.

ZeniMax® id® RoQ video (decoders: roqvideo) (encoders:
roqvideo)

roqEDV.L.

RSupport®/innoheim Screen Capture Codecrscc.DV..S

RealNetworks® RealVideo® 1.0rv10EDV.L.

RealNetworks® RealVideo® 2.0rv20EDV.L.

RealNetworks® RealVideo® 3.0rv30.DV.L.

RealNetworks® RealVideo® 4.0rv40.DV.L.

Lucasfilm® LucasArts® SANM/SMUSH videosanm.DV.L.
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Codec DescriptionCodecLegend

Screenpressoscreenpresso.DV..S

Silicon Graphics® SGI® imagesgiEDVI.S

Silicon Graphics® SGI® RLE 8-bitsgirle.DVI.S

BitJazz SheerVideosheervideo.DVI.S

RAD Game Tools Smacker video (decoders: smackvid)smackvideo.DV.L.

SigmaTel Motion Videosmvjpeg.DV...

SnowsnowEDV.LS

Sunplus JPEG (SP5X)sp5x.DVIL.

Oracle® Sun® Rasterfile imagesunrastEDVI.S

SorensonMedia® VectorQuantizer 1 / SorensonVideo® 1 / SVQ1svq1EDV.L.

SorensonMedia® VectorQuantizer 3 / SorensonVideo® 3 / SVQ3svq3.DV.L.

TrueVision® Targa imagetargaEDVI.S

Pinnacle TARGA CinéWave YUV16targa_y216.DVI..

TDSCtdsc.DV.L.

Electronic Arts TGQ video (decoders: eatgq)tgq.DV.L.

Electronic Arts TGV video (decoders: eatgv)tgv.DV.L.

Xiph.Org™ Theora™theora.DV.L.

Nintendo® Gamecube® THP videothp.DVIL.

Tiertex Limited SEQ videotiertexseqvideo.DV.L.

TIFF imagetiffEDVI.S

8088flex TMVtmv.DVIL.

Electronic Arts TQI video (decoders: eatqi)tqi.DV.L.

Google® (On2/Duck) TrueMotion 1.0truemotion1.DV.L.

Google® (On2/Duck) TrueMotion 2.0truemotion2.DV.L.

Google® (On2/Duck) TrueMotion 2.0 Real Timetruemotion2rt.DV.L.

TechSmith® Screen Capture Codec (decoders: Camtasia®)tscc.DV..S

TechSmith® Screen Codec 2tscc2.DV.L.

RenderWare TXD (TeXture Dictionary) imagetxd.DVIL.

IBM® Ultimotion Digital Video Data Stream Specification
(decoders: ultimotion)

ulti.DV.L.

Ut VideoutvideoEDVI.S

Uncompressed 4:2:2 10-bitv210EDVI.S

Uncompressed 4:2:2 10-bitv210x.DVI.S

Uncompressed packed 4:4:4v308EDVI..
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Codec DescriptionCodecLegend

Uncompressed packed QT 4:4:4:4v408EDVI..

Uncompressed 4:4:4 10-bitv410EDVI.S

Beam Software VBvb.DV.L.

VBLE Lossless Codecvble.DVI.S

SMPTE® VC-1vc1.DV.L.

Windows Media® Video 9 Image v2vc1image.DV.L.

ATI™ VCR1vcr1.DVIL.

Miro VideoXL (decoders: xl)vixl.DVIL.

Sierra Entertainment VMD (Video and Music Data) videovmdvideo.DV.L.

VMware® Screen Codec / VMware® Videovmnc.DV..S

On2 VP3vp3.DV.L.

On2 VP5vp5.DV.L.

On2 VP6vp6.DV.L.

On2 VP6 (Flash® version, with alpha channel)vp6a.DV.L.

On2 VP6 (Flash® version)vp6f.DV.L.

On2 VP7vp7.DV.L.

On2 VP8vp8.DV.L.

Google® VP9vp9.DV.L.

Google®WebPwebp.DVILS

Windows®Media Video 7wmv1EDV.L.

Windows®Media Video 8wmv2EDV.L.

Windows®Media Video 9wmv3.DV.L.

Windows®Media Video 9 Imagewmv3image.DV.L.

Winnov®WNV1wnv1.DVIL.

EA®/Westwood Studios VQA (VectorQuantized Animation) video
(decoders: vqavideo)

ws_vqa.DV.L.

EA®Wing Commander III / Xanxan_wc3.DV.L.

EA®Wing Commander IV / Xxanxan_wc4.DV.L.

eXtended BINary textxbin.DVI..

XBM (X BitMap) imagexbmEDVI.S

X-face imagexfaceEDVIL.

XWD (X Window Dump) imagexwdEDVI.S

Uncompressed YUV 4:1:1 12-bity41pEDVI..

YUY2 Lossless Codecylc.DVI.S
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Codec DescriptionCodecLegend

Psygnosis® YOP Videoyop.DV.L.

Uncompressed packed 4:2:0yuv4EDVI..

ZeroCodec Lossless Videozerocodec.DV..S

LCL (LossLess Codec Library) ZLIBzlibEDVI.S

DOSBox Zip Motion Block VideozmbvEDV..S

Audio-Only Media Files
Codec DescriptionCodecLegend

Electronic Arts 8SVX exponential8svx_exp.DA.L.

Electronic Arts 8SVX fibonacci8svx_fib.DA.L.

AAC (Advanced Audio Coding) (decoders: aac aac_fixed)aacEDA.L.

AAC LATM (Advanced Audio Coding LATM syntax)aac_latm.DA.L.

ATSC A/52A (AC-3) (decoders: ac3 ac3_fixed) (encoders: ac3
ac3_fixed)

ac3EDA.L.

ADPCM 4X Movieadpcm_4xm.DA.L.

SEGA® CRI ADX ADPCMadpcm_adxEDA.L.

ADPCM Nintendo® Gamecube® AFCadpcm_afc.DA.L.

ADPCM Yamaha® AICAadpcm_aica.DA.L.

ADPCM Creative Technologyadpcm_ct.DA.L.

ADPCM Nintendo® Gamecube® DTKadpcm_dtk.DA.L.

ADPCM Electronic Artsadpcm_ea.DA.L.

ADPCM Electronic Arts Maxis® CDROM XAadpcm_ea_maxis_xa.DA.L.

ADPCM Electronic Arts R1adpcm_ea_r1.DA.L.

ADPCM Electronic Arts R2adpcm_ea_r2.DA.L.

ADPCM Electronic Arts R3adpcm_ea_r3.DA.L.

ADPCM Electronic Arts XASadpcm_ea_xas.DA.L.

G.722 ADPCM (decoders: g722) (encoders: g722)adpcm_g722EDA.L.

G.726 ADPCM (decoders: g726) (encoders: g726)adpcm_g726EDA.L.

G.726 ADPCM little-endian (decoders: g726le)adpcm_g726le.DA.L.

ADPCM IMA AMVadpcm_ima_amv.DA.L.

ADPCM IMA CRYO APCadpcm_ima_apc.DA.L.

ADPCM IMA Eurocom DAT4adpcm_ima_dat4.DA.L.

ADPCM IMA On2/Duck DK3adpcm_ima_dk3.DA.L.

ADPCM IMA On2/Duck DK4adpcm_ima_dk4.DA.L.
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Codec DescriptionCodecLegend

ADPCM IMA Electronic Arts EACSadpcm_ima_ea_eacs.DA.L.

ADPCM IMA Electronic Arts SEADadpcm_ima_ea_sead.DA.L.

ADPCM IMA Funcom® ISSadpcm_ima_iss.DA.L.

ADPCM IMA Dialogic (OKI®)adpcm_ima_oki.DA.L.

ADPCM IMA Radicaladpcm_ima_rad.DA.L.

ADPCM IMA Loki SDL MJPEGadpcm_ima_smjpeg.DA.L.

ADPCM IMA WAVadpcm_ima_wavEDA.L.

ADPCM IMA Westwood Studiosadpcm_ima_ws.DA.L.

ADPCM Microsoft®adpcm_msEDA.L.

ADPCM MTAFadpcm_mtaf.DA.L.

ADPCM Playstation®adpcm_psx.DA.L.

ADPCM Sound Blaster® Pro 2-bitadpcm_sbpro_2.DA.L.

ADPCM Sound Blaster® Pro 2.6-bitadpcm_sbpro_3.DA.L.

ADPCM Sound Blaster® Pro 4-bitadpcm_sbpro_4.DA.L.

ADPCM Shockwave® Flash®adpcm_swfEDA.L.

ADPCM Nintendo® THPadpcm_thp.DA.L.

ADPCM Nintendo® THP (Little-Endian)adpcm_thp_le.DA.L.

LucasArts® VIMA audioadpcm_vima.DA.L.

ADPCM CDROM XAadpcm_xa.DA.L.

ADPCM Yamaha®adpcm_yamahaEDA.L.

ALAC (Apple® Lossless Audio Codec)alacEDA..S

AMR-NB (Adaptive Multi-Rate NarrowBand) (decoders: amrnb)amr_nb.DA.L.

AMR-WB (Adaptive Multi-Rate WideBand) (decoders: amrwb)amr_wb.DA.L.

Monkey's Audioape.DA..S

Sony® ATRAC1 (Adaptive TRansform Acoustic Coding)atrac1.DA.L.

Sony® ATRAC3 (Adaptive TRansform Acoustic Coding 3)atrac3.DA.L.

Sony® ATRAC3+ (Adaptive TRansform Acoustic Coding 3+)
(decoders: atrac3plus)

atrac3p.DA.L.

On2 Audio for Video Codec (decoders: on2avc)avc.DA.L.

Bink® Audio (DCT)binkaudio_dct.DA.L.

Bink® Audio (RDFT)binkaudio_rdft.DA.L.

Discworld® II BMV audiobmv_audio.DA.L.

RFC 3389 Comfort NoisecomfortnoiseEDA.L.

Cook / Cooker / Gecko (RealAudio® G2)cook.DA.L.
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Codec DescriptionCodecLegend

DSD (Direct Stream Digital), least significant bit firstdsd_lsbf.DA.L.

DSD (Direct Stream Digital), least significant bit first, planardsd_lsbf_planar.DA.L.

DSD (Direct Stream Digital), most significant bit firstdsd_msbf.DA.L.

DSD (Direct Stream Digital), most significant bit first, planardsd_msbf_planar.DA.L.

Delphine Software International CIN audiodsicinaudio.DA.L.

Digital Speech Standard - Standard Play mode (DSS SP)dss_sp.DA.L.

DST (Direct Stream Transfer)dst.DA..S

DCA (DTS Coherent Acoustics) (decoders: dca) (encoders: dca)dtsEDA.LS

DV audiodvaudio.DA.L.

ATSC A/52B (AC-3, E-AC-3)eac3EDA.L.

EVRC (Enhanced Variable Rate Codec)evrc.DA.L.

FLAC (Free Lossless Audio Codec)flacEDA..S

G.723.1g723_1EDA.L.

G.729g729.DA.L.

GSMgsm.DA.L.

GSM Microsoft® variantgsm_ms.DA.L.

IAC (Indeo Audio Coder)iac.DA.L.

IMC (Intel®Music Coder)imc.DA.L.

DPCM Interplayinterplay_dpcm.DA.L.

Interplay® ACMinterplayacm.DA.L.

MACE (Macintosh® Audio Compression/Expansion) 3:1mace3.DA.L.

MACE (Macintosh® Audio Compression/Expansion) 6:1mace6.DA.L.

Voxware®MetaSoundmetasound.DA.L.

MLP (Meridian Audio Lossless Packing)mlpEDA..S

MP1 (MPEG audio layer 1) (decoders: mp1 mp1float)mp1.DA.L.

MP2 (MPEG audio layer 2) (decoders: mp2mp2float) (encoders:
mp2 mp2fixed)

mp2EDA.L.

MP3 (MPEG audio layer 3) (decoders: mp3 mp3float)mp3.DA.L.

ADU (ApplicationDataUnit)MP3 (MPEGaudio layer 3) (decoders:
mp3adu mp3adufloat)

mp3adu.DA.L.

MP3onMP4 (decoders: mp3on4 mp3on4float)mp3on4.DA.L.

MPEG-4 Audio Lossless Coding (ALS) (decoders: als)mp4als.DA..S

Musepack SV7 (decoders: mpc7)musepack7.DA.L.

Musepack SV8 (decoders: mpc8)musepack8.DA.L.

Nellymoser AsaonellymoserEDA.L.
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Opus (Opus Interactive Audio Codec)opus.DA.L.

Amazing Studio Packed Animation File Audiopaf_audio.DA.L.

PCM A-law / G.711 A-lawpcm_alawEDA.L.

PCM signed 16|20|24-bit big-endian for Blu-ray mediapcm_bluray.DA..S

PCM signed 20|24-bit big-endianpcm_dvd.DA..S

PCM 32-bit floating point big-endianpcm_f32beEDA..S

PCM 32-bit floating point little-endianpcm_f32leEDA..S

PCM 64-bit floating point big-endianpcm_f64beEDA..S

PCM 64-bit floating point little-endianpcm_f64leEDA..S

PCM signed 20-bit little-endian planarpcm_lxf.DA..S

PCM mu-law / G.711 mu-lawpcm_mulawEDA.L.

PCM signed 16-bit big-endianpcm_s16beEDA..S

PCM signed 16-bit big-endian planarpcm_s16be_planarEDA..S

PCM signed 16-bit little-endianpcm_s16leEDA..S

PCM signed 16-bit little-endian planarpcm_s16le_planarEDA..S

PCM signed 24-bit big-endianpcm_s24beEDA..S

PCM D-Cinema audio signed 24-bitpcm_s24daudEDA..S

PCM signed 24-bit little-endianpcm_s24leEDA..S

PCM signed 24-bit little-endian planarpcm_s24le_planarEDA..S

PCM signed 32-bit big-endianpcm_s32beEDA..S

PCM signed 32-bit little-endianpcm_s32leEDA..S

PCM signed 32-bit little-endian planarpcm_s32le_planarEDA..S

PCM signed 64-bit big-endianpcm_s64beEDA..S

PCM signed 64-bit little-endianpcm_s64leEDA..S

PCM signed 8-bitpcm_s8EDA..S

PCM signed 8-bit planarpcm_s8_planarEDA..S

PCM unsigned 16-bit big-endianpcm_u16beEDA..S

PCM unsigned 16-bit little-endianpcm_u16leEDA..S

PCM unsigned 24-bit big-endianpcm_u24beEDA..S

PCM unsigned 24-bit little-endianpcm_u24leEDA..S

PCM unsigned 32-bit big-endianpcm_u32beEDA..S

PCM unsigned 32-bit little-endianpcm_u32leEDA..S

PCM unsigned 8-bitpcm_u8EDA..S

PCM Zorkpcm_zork.DA.L.
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Codec DescriptionCodecLegend

QCELP / Qualcomm® PureVoice®qcelp.DA.L.

QDesign Music Codec 2qdm2.DA.L.

RealAudio® 1.0 (14.4K) (decoders: real_144) (encoders: real_144)ra_144EDA.L.

RealAudio® 2.0 (28.8K) (decoders: real_288)ra_288.DA.L.

RealAudio® Losslessralf.DA..S

DPCM id RoQroq_dpcmEDA.L.

SMPTE 302Ms302mEDA..S

DPCM Squareroot-Delta-Exactsdx2_dpcm.DA.L.

Shortenshorten.DA..S

RealAudio® SIPR / ACELP.NETsipr.DA.L.

Smacker audio (decoders: smackaud)smackaudio.DA.L.

DPCM Solsol_dpcm.DA.L.

SonicsonicEDA...

TAK (Tom's lossless Audio Kompressor)tak.DA..S

Dolby® TrueHDtruehdEDA..S

DSP Group TrueSpeechtruespeech.DA.L.

TTA (True Audio)ttaEDA..S

VQF TwinVQtwinvq.DA.L.

Sierra Entertainment VMD audiovmdaudio.DA.L.

Xiph.Org™ VorbisvorbisEDA.L.

Wave synthesis pseudo-codecwavesynth.DA...

WavePackwavpackEDA.LS

Westwood Studios Audio (SND1) (decoders: ws_snd1)westwood_snd1.DA.L.

Windows Media® Audio Losslesswmalossless.DA..S

Windows Media® Audio 9 Professionalwmapro.DA.L.

Windows Media® Audio 1wmav1EDA.L.

Windows Media® Audio 2wmav2EDA.L.

Windows Media® Audio Voicewmavoice.DA.L.

Electronic Arts DPCM Xanxan_dpcm.DA.L.

Xbox®Media Audio 1xma1.DA.L.

Xbox®Media Audio 2xma2.DA.L.

To Import Media Files
Transcode a media file of a different format to a clip that can be played in the server.
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Tip: You can close the Kiva Import application at any point during an import to stop the process. When you start the Kiva Import
application again, it will detect the import queue and prompt you to resume.

1. Launch the Kiva Import application.
2. In the Import Method list, select the how you want to import the media file.

• Software Transcode — use the software based transcoder to import the media file that is in a
different media format than your hardware.

• Native Import Only: No Transcoding — import the media file that is in the native media format
for your hardware.

Tip: Select Native Import Only if the file you are importing is AVC-Intra 100.mov/.mxf or use the Software Transcoder for any
published codec. No channels are consumed for either of these operations.

The Kiva Import window is shown.

3. Click Import From and select the folder that the media files you want to import are located in.

Tip: If you want to point the import application to a network drive, you must map that drive in Windows® before you can select it as
a source.

4. Click Choose.
5. Click Destination and select the H:\Video folder, or a folder below this one, on the media drive.

Note: The destination must be under the H:\Video folder on the media drive or the imported files will not be available to the
server.

6. Click the green add files (+) button and select the media files that you want to import.
7. Click Add Files.

Tip: If you want to remove files from the import list, select the files and click the red remove files (-) button. The files are not deleted,
only removed from the import queue.

Tip: You can change the order that the files are imported by selecting the file(s) you want to move and click the up or down arrow
buttons on the right of the window. The file(s) are moved up or down in the list. You can also drag and drop the files to order the files.

To Add a Watch Folder
You can create multiple watch folders that the import utility will monitor and automatically import any
media files that are modified or copied into the watch folder(s).
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Note: The Kiva Import applicationmust be running for the watch folder functionality to work. You can set up the application to automatically
launch and start the watch folder function when the server is powered on.

1. Launch the Kiva Import application.
2. In the Import Method list, select the how you want to import the media file.

• Software Transcode — use the software based transcoder to import the media file that is in a
different media format than your hardware.

• Native Import Only: No Transcoding — import the media file that is in the native media format
for your hardware.

Tip: Select Native Import Only if the file you are importing is AVC-Intra 100.mov/.mxf or use the Software Transcoder for any
published codec. No channels are consumed for either of these operations.

The Kiva Import window is shown.

3. Click File > Watch Folders....
4. Click Add Watch Folder... and select the folder that you want Kiva Import to watch.

The folder can be on the local media drive or a network drive.

5. Click Select Folder to add the folder to the watch list. Repeat for any additional folders you want
Kiva Import to watch.

Tip: You can remove a folder from the watch list by selecting it and clicking Remove Watch Folder.
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6. Click OK.
7. Select Enable Watch Folder to start importing from the watch folders.

To Configure Kiva Import
The Kiva Import configuration menus allow you to change the destination folder, set how the RGB
color space is interpreted, the raster size of the imported video, set up a watch folder, and to set an auto
start behavior.
1. Launch the Kiva Import application.
2. In the Import Method list, select the how you want to import the media file.

• Software Transcode — use the software based transcoder to import the media file that is in a
different media format than your hardware.

• Native Import Only: No Transcoding — import the media file that is in the native media format
for your hardware.

Tip: Select Native Import Only if the file you are importing is AVC-Intra 100.mov/.mxf or use the Software Transcoder for any
published codec. No channels are consumed for either of these operations.

The Kiva Import window is shown.

3. Click Edit > Configure.
4. Click the Destination tab and click Change and select a new destination folder for import.

5. Click the Color tab and select how the RGB luminance color range is interpreted when a file is
imported.
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• Normal — color luminance range is scaled from 0 to 255.
• Prescaled to 10-235 — color luminance range is scaled from 10 to 235.

Note: Do not use Prescaled to 10-235 when importing a clip with an alpha channel (VK clips). The alpha channel will not import
properly. Use Normal when importing a clip with an alpha channel.

Tip: If the blacks of your imported media files appear crushed or the whites do not appear as bright as expected, try selecting the
opposite mode.

6. Click the Watch tab and set the amount of time the system will wait after it has detected a new file
in the watch folder and how often it polls remote file servers. These settings are used in conjunction
with the AutoStart configurations and the watch folder selection.

• File Settle Time— the length of time the import application will wait after a file has been modified
before starting to import it. If the media files are being rendered directly into the watch folder,
set a long wait time. If the watch folder is being used for drag and drop, set a short wait time.

• Remote Fileserver Rescan Interval — the length of time the import application waits to poll an
external server for changes. This setting is ignored if the external server is running a Windows®

operating system.

7. Click the AutoStart tab and select whether the Kiva Import application is started automatically,
and whether the selected folders are watched.
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• Start importer 30 seconds after login— the Kiva Import application will be started 30 seconds
after you log into Windows®.

• Enable watch folders at login — the watch folder functionality will start automatically with
Kiva Import.

• Import Channel — select the Media Player to be used for import when the import application
starts automatically.

8. Click the Import Codec tab and select codec you want to use when a file is imported.

• QuickTime — the Apple® QuickTime® codec is not supported at this time.
• FFmpeg — use the FFmpeg™ codec.
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Remote Control Support
Use the information in this section to assist you in setting up an external device to control your server.

Remote Communications (RS-422)
Direct serial control of each Media Player on the server is available through the RJ45 ports on the breakout
cable connected to the server. Ethernet communications can also be used to control a Media Player
instead of the direct serial connection.

Note: The BVW-75 and Odetics protocols are not supported over ethernet at this time.

The numbering on the cable indicates which Media Players on the presenter it controls.

Media PlayerCable

Ch1 PGM V —Media player 1 video on program.ChA

Ch1 PVW V —Media player 1 video on preview.ChB

Ch1 PGM K —Media player 1 video on program.ChC

Ch1 PVW K —Media player 1 video on program.ChD

Ch2 PGM V —Media player 2 video on program.ChE

Ch2 PVW V —Media player 2 video on preview.ChF

Ch2 PGM K —Media player 2 video on program.ChG

Ch2 PVW K —Media player 2 video on program.ChH

The procedure for setting up a room for external control depends on the protocol you want to use.

To Configure a Room for the BVW-75 Protocol
Set up a Room to use the BVW-75 protocol to control server channels.

Note: The BVW-75 protocol does not support clip library listing or clip loading.

1. Launch the Kiva Config application.
You may be prompted to allow the program to make changes on the computer, click Yes.

2. Click the RS422 tab.
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3. Click Room X Configuration and select the room you want to configure. Later you will assign this
room to a channel.

4. In the RS422 Protocol area, select BVW-75.
5. In the Response Time area, select how quickly the server executes the Clip Play command after the

Clip Load command.
• Fast — executes the play command immediately after the load command. This is recommended

when controlling the server from an external switcher.
• Accurate— executes the play command only after receiving confirmation that the clip has loaded.

This is recommended when controlling the server from an automation system.

6. In the Edit Timing area, select a timing offset for when you are controlling the server from an external
editor over serial.
• Timecode Alignment — select the offset, in frames, of the timecode information that is sent to

the editor during playout or record.
• Source Alignment — select the offset, in frames, of the timecode information that is sent to the

editor during playout.
• Out Point Offset — select the offset, in fields, of the out-point timecode value that is sent to the

editor during record.

7. In the Video Edit Effect area, select which tracks get recorded when an external editor issues the
Video Record command to the server.
• Edit Video Track — only the video track is recorded.
• Edit Key Track — only the alpha (key) track is recorded.
• Edit Video and Key Tracks— both the video and alpha (key) tracks are recorded. The clip loaded

into the VKA Media Player must have an alpha track.

8. In the BVW-75 Protocol Configuration area, select specific configurations for the protocol you are
using.
• Select Disable field timecode reporting to force the server to report timecode only once every

video frame. If this option is not selected, the server reports timecode every field.
• Select the Protocol ID that you want to use (Abekas 6000, Sony BVW-75, or Generic DDR).

9. Click on the Ch-X XXX X: list and select the room that you want to assign to the channel.
10. Click Restart Kiva. A confirmation dialog box is displayed.
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11. Click Restart Kiva to restart the server application and services with the new setting.
12. Click OK when the restart has completed to dismiss the window.

To Configure a Room for the Odetics Protocol
Set up a Room to use the Odetics protocol to control server channels.
1. Launch the Kiva Config application.

You may be prompted to allow the program to make changes on the computer, click Yes.

2. Click the RS422 tab.

3. Click Room X Configuration and select the room you want to configure. Later you will assign this
room to a channel.

4. In the RS422 Protocol area, select Odetics.
5. In the Response Time area, select how quickly the server executes the Clip Play command after the

Clip Load command.
• Fast — executes the play command immediately after the load command. This is recommended

when controlling the server from an external switcher.
• Accurate— executes the play command only after receiving confirmation that the clip has loaded.

This is recommended when controlling the server from an automation system.

6. In the Edit Timing area, select a timing offset for when you are controlling the server from an external
editor over serial.
• Timecode Alignment — select the offset, in frames, of the timecode information that is sent to

the editor during playout or record.
• Source Alignment — select the offset, in frames, of the timecode information that is sent to the

editor during playout.
• Out Point Offset — select the offset, in fields, of the out-point timecode value that is sent to the

editor during record.

7. In the Video Edit Effect area, select which tracks get recorded when an external editor issues the
Video Record command to the server.
• Edit Video Track — only the video track is recorded.
• Edit Key Track — only the alpha (key) track is recorded.
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• Edit Video and Key Tracks— both the video and alpha (key) tracks are recorded. The clip loaded
into the VKA Media Player must have an alpha track.

8. In the Odetics Protocol Configuration area, select specific configurations for the protocol you are
using.
• Select Disable field timecode reporting to force the server to report timecode only once every

video frame. If this option is not selected, the server reports timecode every field.
• Select the Protocol ID that you want to use (Abekas 6000, Sony BVW-75, or Generic DDR).

9. Click on the Ch-X XXX X: list and select the room that you want to assign to the channel.
10. Click Restart Kiva. A confirmation dialog box is displayed.
11. Click Restart Kiva to restart the server application and services with the new setting.
12. Click OK when the restart has completed to dismiss the window.

To Configure a Room for the VDCP Protocol
Set up a Room to use the VDCP (Louth) protocol to control server channels.

Note: When controlling the server from a remote device over ethernet, you must select the port on the server corresponding to the Media
Player you want to send commands to. For example, Media Player 1 program video = port 8000, Media Player 1 preview video = port 8001,
and so on.

1. Launch the Kiva Config application.
You may be prompted to allow the program to make changes on the computer, click Yes.

2. Click the RS422 tab.

3. Click Room X Configuration and select the room you want to configure. Later you will assign this
room to a channel.

4. In the RS422 Protocol area, select VDCP.
5. In the Restrict to Folder area, select if you want to restrict remote control of the selected room to

only seeing the contents of a specific profile, or all profiles (All Folders).
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6. In the Response Time area, select how quickly the server executes the Clip Play command after the
Clip Load command.
• Fast — executes the play command immediately after the load command. This is recommended

when controlling the server from an external switcher.
• Accurate— executes the play command only after receiving confirmation that the clip has loaded.

This is recommended when controlling the server from an automation system.

7. In the Channel Control Port area, select whether you want to use the serial ports or ethernet
connection for the channels assigned to the room.

8. In the Edit Timing area, select a timing offset for when you are controlling the server from an external
editor over serial.
• Timecode Alignment — select the offset, in frames, of the timecode information that is sent to

the editor during playout or record.
• Source Alignment — select the offset, in frames, of the timecode information that is sent to the

editor during playout.
• Out Point Offset — select the offset, in fields, of the out-point timecode value that is sent to the

editor during record.

9. In the Video Edit Effect area, select which tracks get recorded when an external editor issues the
Video Record command to the server.
• Edit Video Track — only the video track is recorded.
• Edit Key Track — only the alpha (key) track is recorded.
• Edit Video and Key Tracks— both the video and alpha (key) tracks are recorded. The clip loaded

into the VKA Media Player must have an alpha track.

10. In the VDCP Configuration area, select specific configurations for the protocol you are using.
• Select Louth Preview to allow clips to be pre-cued in the background for seamless back-to-back

transitions during playout.
• Select Allow playlists control to allow a playlist to be cued and played from an external device

just like a clip.
• In the Maximum length of Clip Name field, select the maximum length of a clip name that is

reported to the controlling device.

11. Click on the Ch-X XXX X: list and select the room that you want to assign to the channel.
12. Click Restart Kiva. A confirmation dialog box is displayed.
13. Click Restart Kiva to restart the server application and services with the new setting.
14. Click OK when the restart has completed to dismiss the window.

To Configure a Room for the AMP Protocol
Set up a Room to use the AMP protocol to control server channels.

Note: When controlling the server from a remote device over ethernet, you must select the port as 3811 and then select the channel you
want to send the commands to.

1. Launch the Kiva Config application.
You may be prompted to allow the program to make changes on the computer, click Yes.

2. Click the RS422 tab.
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3. Click Room X Configuration and select the room you want to configure. Later you will assign this
room to a channel.

4. In the RS422 Protocol area, select AMP over Ethernet.
5. In the Response Time area, select how quickly the server executes the Clip Play command after the

Clip Load command.
• Fast — executes the play command immediately after the load command. This is recommended

when controlling the server from an external switcher.
• Accurate— executes the play command only after receiving confirmation that the clip has loaded.

This is recommended when controlling the server from an automation system.

6. In the Edit Timing area, select a timing offset for when you are controlling the server from an external
editor over serial.
• Timecode Alignment — select the offset, in frames, of the timecode information that is sent to

the editor during playout or record.
• Source Alignment — select the offset, in frames, of the timecode information that is sent to the

editor during playout.
• Out Point Offset — select the offset, in fields, of the out-point timecode value that is sent to the

editor during record.

7. In the Video Edit Effect area, select which tracks get recorded when an external editor issues the
Video Record command to the server.
• Edit Video Track — only the video track is recorded.
• Edit Key Track — only the alpha (key) track is recorded.
• Edit Video and Key Tracks— both the video and alpha (key) tracks are recorded. The clip loaded

into the VKA Media Player must have an alpha track.

8. In the AMP Protocol Configuration area at the bottom of the window, select specific configurations
for the protocol you are using.
• Select Disable field timecode reporting to force the server to report timecode only once every

video frame. If this option is not selected, the server reports timecode every field.
• Select Allow overlapped commands to allow the server to accept overlapping commands.
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• Select Allow playlists control to allow a playlist to be cued and played from an external device
just like a clip.

• Select the Protocol ID that you want to use (Abekas 6000, Sony BVW-75, or Generic DDR).

9. Click on the Ch-X XXX X: list and select the room that you want to assign to the channel.
10. Click Restart Kiva. A confirmation dialog box is displayed.
11. Click Restart Kiva to restart the server application and services with the new setting.
12. Click OK when the restart has completed to dismiss the window.

DashBoard
The DashBoard control system allows remote access to multiple pieces of Ross Video equipment, including
openGear® cards, Carbonite production switchers, Ross video servers, and Ross cameras. Download and
install the latest version of DashBoard from www.rossvideo.com/support/software-downloads/.
Review the documentation that comes with DashBoard for information on installing and launching
DashBoard.
To control Kiva from DashBoard you must create a custom panel in DashBoard using PanelBuilder to
send VDCP or Kiva Ethernet API commands to the server.

Note: DashBoard can only display active video for a Media Player if DashBoard is running on the same Kiva server. Active video for a Media
Player cannot be shown in DashBoard when DashBoard is running on a separate computer.

Abekas® DashBoard Service
The Abekas® OGP (openGear® Protocol) Service allows you to connect to your server from DashBoard.

To Install the Abekas® OGP Service
The AbekasOGP application should already be installed on your server. If it is not, you can download
and install the application manually.
1. Navigate to the Downloads section of the Ross® website for your server product and download the

Abekas® OGP DashBoard Service.

Tip: For example, if you have a Mira server, you would navigate to https://www.rossvideo.com/support/software-downloads/mira/.

2. Run the Abekas_#.#.#_setup.exe application on your server and follow the wizard to install the
service.

To Connect to Kiva from DashBoard
1. Click File > New > TCP/IP DashBoard Connect or openGear Device.

2. In the IP Address field, enter the IP address of the Kiva chassis. The default IP address is 192.168.0.1.
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3. In theDisplayName field, enter the name you want to use to identify the Kiva chassis in DashBoard.
This should be a unique name for the Kiva you are setting up.

4. Select JSON.
5. In the Port field, enter 5254.
6. Click Finish.

The Kiva you are connecting to appears in the Tree View.

DashBoard Interface
The server appears as a node in the DashBoard Basic Tree View. The Replay and Explorer sub-nodes
can be expanded to show the Operator and Explorer pages.

Replay
The Operator 1 and Operator 2 pages are also known as MiraTouch Horse Racing panels and are
intended to be used in a 4-in/2-out replay configuration for horse racing.

Explorer
The Explorer and Explorer Touch pages mirror the operation of the Explorer application of your server.
The Explorer Touch page is smaller version designed to fit into Live Assist.

Tip: Portions of these pages can be dragged onto a custom panel in DashBoard PanelBuilder.
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Palette
The Palette page provides a number of widgets for use in PanelBuilder.

PanelBuilder Custom Panel Attributes
When building a custom panel in DashBoard, you can connect to your server as a data source. This
allows you access to numerous powerful commands and parameters native to your server.

To Add a Server Command to a Custom Panel
1. Double-click on the canvas of your custom panel and click the openGear or XPression DataLinq

Configure button.
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2. Click Select a device and select Abekas.
3. Click OK.

The Current below the button shows the Abekas server.

4. Insert a button or other interface element to your custom panel.

5. Edit your interface element as normal and click Add in the Tasks area.
You can now drag and drop Abekas® server commands to the script editor to create visual logic
chains.
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Clip ID Support
Devices using the VDCP or Odetics protocol can use the 8-character clip ID assigned to a clip. By default,
the server does not assign a clip ID to the clip when it is recorded. If there is no clip ID, the first 8
characters of the clip name are used instead.

Sony® MVS Series Switcher
Use the following information to set up your Sony® MVS series switcher to control the server as either
a Recorder or Player device.

Table 1: VDCP RS422 Protocol Constants

SettingItemNo.

(1-N)*Video Port1

10Maximum Open Delay2

0Maximum Cueup Delay3

0Play After Cueup Delay4

2Stop Delay5

6Still Delay6

0Continue Delay7

2Idle Delay8

* Set this value to the MVS virtual RS422 Port # that is connected to the server.
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Kiva Presenter
The Kiva Presenter provides a shot-box style interface with Video Program and Preview Media Players
with separate and independent Audio Program and Preview Media Players.
Video and audio clips and stills can be assigned to Media Buttons that allow you to quickly load and play
media items, or create playlists of media items that can also be assigned to Media Buttons. Both the
Audio and Video Media Players have standard transport controls with separate and independent audio
metering and level control.

Note: If you have a system with two channel pairs, you can switch between the pairs by click the Channel Pair button at the top right of
the screen. Media Button assignments on both channel pairs is stored in the same session.

Sessions
Kiva Presenter uses sessions to store Media Button information and Page and Bank layouts.
When you launch Kiva Presenter you are prompted to load or create a session. The session contains a
database that stores all the Media Button assignments and media item information. The session is
continuously updated and saved during operation.

Tip: You can switch sessions at any time by clicking File > Switch Sessions.

Sessions Manager
The Sessions Manager allows you to load, copy, and delete sessions.
When you launch Kiva Presenter, the Sessions Manager dialog box prompts you to load a session. You
can also use this dialog box to copy to contents of the selected session to a new session, or delete the
selected session.

Note: Deleting or copying a session does not change the media used in the session, only the session database.
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Settings
Player and global setting allow the customization of the Kiva Presenter interface.
These setting are stored in the session and apply to all channel pairs.

To Set the Player Settings
Player settings provide default parameters for the audio and video media players.
1. Click Settings > Player Settings.

2. Set the default Player settings as follows:

DescriptionSetting

Set the type of transition that is used to take a media item from the Video Preview Media
Player to the Video Program Media Player.
• MIX—a dissolve from the Programmedia item to the Previewmedia item. The duration

of the mix is set in the next parameter.
• CUT—acut from the Programmedia item to the Previewmedia item.Noduration setting

is used for a cut.

Video Player Transition

Set the length of time for a take, in frames, to mix (dissolve) from the Video Program Media
Player media item to the Video Preview Media Player media item. A cut does not have a
duration.

Video Transition Duration

Set the type of transition used to take an audio clip from the Audio Preview Media Player to
the Audio Program Media Player.
• MIX—a dissolve takes the audio clip from the Audio ProgramMedia Player to the Audio

Preview Media Player. The duration of the mix is set in the next parameter.
• CUT— a cut takes the audio clip from the Audio Program Media Player to the Audio

Preview Media Player. No duration setting is used for a cut.

Audio Player Transition

Set the length of time for a take, in frames, to fade the audio clip from the Audio Program
Media Player to the Audio Preview Media Player. A cut does not have a duration.

Audio Transition Duration

Set what action is taken when a media item is taken on Video Program Media Player.
• PLAY— start playing the media item immediately when it is taken on the Video Program

Media Player.
• PAUSE—pause on the first frameof themedia itemwhen it is taken on the Video Program

Media Player.

VIDEOPGMPlayer@START of
CLIP
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DescriptionSetting

Set what action the Video ProgramMedia Player performswhen it reaches the end of amedia
item when it is not set to automatically transition to the next media item.
• PAUSE— pause on the last frame of the media item when the Video Program Media

Player reaches the end of the media item.
• CUT to BLACK— transition to internally generated black when the Video ProgramMedia

Player reaches the end of the media item.

VIDEO PGM Player @END of
CLIP

Set what action is performedwhen an audio clip is taken on the Audio ProgramMedia Player.
• PLAY— start playing the audio clip immediately when it is taken on the Audio Program

Media Player.
• PAUSE— stop the audio clip as soon as it is taken on the Audio Program Media Player.

AUDIO PGM Player @START
of CLIP

Set the point in time when the count-down timer turns yellow during playout. This applies to
both the Audio and Video Media Players.

Player Count-down YELLOW
Alert @

Set the action that is performed when a Media Button is clicked.
• LOAD in PVW / TAKE to PGM— load the contents of the Media Button into the PVW

Media Player when the Media Button is clicked the first time and take the contents of the
Media Button button on the PGMMedia Player when the button is clicked a second time.

• LOADDIRECT to PGM—load the contents of theMedia Button into the PGMMedia Player
when the Media Button is clicked the first time.

Media Button Hotkey Action

To Set the Global Settings
Global settings provide default parameters for the Audio and Video Media Players, as well as some global
interface settings.
1. Click Settings > Global Settings.

2. Set the default Global settings as follows:

DescriptionSetting

Set the position of the frame that is used to create the thumbnail for a newmedia item. Does
not apply to audio.
• FIRST FRAME— use the first frame in the media item to create the thumbnail.
• MIDDLE FRAME— use the middle frame in the media item to create the thumbnail.
• CUSTOMFRAME—use a custom framenumber in themedia item to create the thumbnail.

The frame number is set in the next item.

Video Clip Thumbnail Frame
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DescriptionSetting

Set a custom frame that is used to create the thumbnail for the Media Player. If the frame is
beyond the end of the media, the last frame is selected.

Thumbnail Custom Frame
Number

Set the default duration that is applied when a still is assigned to a Media Button. This is the
duration that the still image stays on the Video Program Media Player during playout.

StillMedia ButtonDefault Play
Duration

Set the format that is used when displaying timecode. Timecode is shown on each Media
Button as well as the Media Player.
• MM:SS—minutes : seconds
• MM:SS:FF—minutes : seconds : frames
• HH:MM:SS:FF— hours : minuntes : seconds : frames

Timecode Display Format

Set whether the thumbnail on the video Media Buttons plays a preview of the clip when the
mouse hovers over the Media Button (ON), or if only the static thumbnail is shown (OFF).
Does not apply to stills or audio. The delay between when the mouse starts to hover and the
preview plays is set in the next item.

Video Media Button
Thumbnail Play

Set the length of time between hovering the mouse over a Media Button and the preview
playing. This setting only applies when the Video Media Button Thumbnail Play is set to
ON.

Video Media Button
Thumbnail Play Delay

Hot Keys
Keyboard shortcuts can be used to perform a variety of actions, such as activating various controls, or
load a Media Button.

Tip: You can edit the current hot keys by clicking Edit > Edit Hot Keys and entering a new keyboard button sequence in the Shortcut field
next to the command you want to change the hot key for.
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To Assign a Hotkey to a Media Button
Assign a specific key combination to a Media Button that allows you to quickly cue or play the contents
of that Media Button.
1. Right-click on the Media Button that you want to apply a hot key combination to and click Assign /

Remove Hotkey.... The Media Button must have a media item assigned to it.
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2. In the Hotkey Sequence field, enter the keyboard button sequence you want to use for that Media
Button.

Tip: The hotkey button presses must be entered in rapid succession or they will overwrite each other. The ... is shown while button
presses are accepted as part of the sequence.

3. Click OK.

To Use a Hotkey to Load a Media Button
You can use a hotkey combination to load a Media Button.

Note: The action the hotkey performed depends on theMedia Button Hot Key Action in the Player Settings.

1. Ensure that the Kiva Presenter window has focus.
2. Use the keyboard to enter the button sequence that is assigned to the Media Button you want to load.

Tip: Right-click on a Media Button to see the action and hotkey sequence that has been applied to it. The hotkey is shown below the
Assign / Remove Hotkey...

Tip: If theMedia Button Hot Key Action is set to LOAD in PVW / TAKE to PGM pressing the hotkey agiain will take the media item
to Program.

Tip: You can view all hotkeys that are assigned to Media Buttons by clicking Edit > Edit Hot Keys... >Media Button Hotkeys.
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Media Buttons
The Media Buttons allow you to quickly load and present media items on the Audio or Video Media
Players. The type of Media Button defines which Media Player the media item is loaded into.
When a media item is assigned to a Media Button, a database entry for that media item is created that
is independent of the original media item. This allows you to use the same media item in multiple Media
Buttons and adjust the IN/OUT points and audio levels without changing the other Media Button, or the
original media item.

Tip: You can also assign a playlist to a Media Button. Refer to Playlists on page 61 for more information.

Media Buttons are organized into 6 banks of 14 pages with each page containing 60 buttons. The Media
Buttons, pages, and banks are independent between the channel pairs and sessions.

Tip: Click a Media Button to load the contents of that Media Button onto the Video or Preview Media Player, or double-click a Media Button
to load the contents onto the Video or Audio Preview Media Player and immediately take it onto the Program Media Player.

Media Button Type Assignment
When you assign a media item to a Media Button, you select the type of Media Button you want to use.
This doesn't change the media item, but how Kiva Presenter uses it.
Media Buttons can be assigned to one of three basic types or used for a playlist. What the Media Button
is assigned to is identified by the icon on the Media Button and the color used behind the name. You
cannot change the type of an existing Media Button, but you can assign the media item to multiple Media
Buttons.

DescriptionIcon

The Video Media Button is used to contain a video clip and is played on the Video Preview (PVW)
and Program (PGM) Media Players.

The Still Media Button is used to contain a still image and is played on the Video Preview (PVW)
or Program (PGM) Media Playera.

The AudioMedia Button is used to contain an audio clip and is played on the Audio Preview (PVW)
or Program (PGM) Media Player, or on the Video Media Player when it is part of a playlist. The
Audio Media Player can be playing out at the same time as the Video Media Player.

The Playlist Media Button is used to contain a playlist of media items with transition controls for
how each item is transitions from Preview (PVW) to Program (PGM) during playout. When an
Audio only media item is played from a playlist, the Video Media Player is used. The Video Media
Player outputs black while playing an audio clip.

The media file that was assigned to the Media Button is missing or has been renamed. If you
move, delete, or rename a media file assigned to a Media Button, the link to the media file is
broken and the Media Button will not function.
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To Assign a Media Item to a Media Button
Tip: You can assign the same media item to multiple Media Buttons and set different IN and OUT points for each. This allows you generate
multiple Media Buttons from the same parent media item.

1. Right-click on the empty Media Button location that you want to assign a media item to.

2. Select Assign and click on the type of Media Button you want to create.
• Video — creates a Video Media Button that will contain a video clip. The video clip can have

embedded audio and/or alpha.
• Audio — creates an Audio Media Button that will contain an audio clip or the embedded audio

from a video clip.
• Still — creates a Still Media Button that will contain a still image or a single frame from a video

clip.

Tip: You can assign a media item of a different type to a Media Button. For example, you can assign a video + audio (V+A) clip to an
Audio Media Button. The audio is loaded into the Audio Media Players when the Media Button is loaded.

3. Select the media file that you want to assign to the selected Media Button.

Note: Only valid media files for the selected type of Media Button are shown.

Tip: Use the Search in the top right corner to quickly find a particular clip.

Tip: The Tracks column shows whether the media item contains video (V), alpha/key (K), audio (A), and timecode (T).

4. Click OK.

The media item is assigned to the Media Button and a thumbnail is generated for Video and Still Media
Buttons. Refer to To Set the Global Settings on page 53 for information on the default frame that the
thumbnail is taken from.

58 • Kiva Presenter — Kiva User Manual (v9.0)



Media Button Pages
The Media Button Pages allow you to organize your Media Buttons for how they best fit your workflow.
Media Button can be moved from one location to another on the Page, or between different Pages, Banks,
and even Channel Pairs.

Each Channel Pair has an independent set of 60 Banks, Pages, and Buttons. There are 6 Banks, each
containing 14 Pages, and each Page contains 60 Media Buttons.

Tip: Refer to Organizer Mode on page 59 for more information on moving Media Buttons.

When the contents of a Media Button is on Preview or Program, the Media Button, Page, and Bank are
tallied. Red for when the contents of a Media Button is loaded into the Audio or Video Program (PGM)
Media Player and green for when it is loaded into the Audio or Video Preview (PVW) Media Player.

Green and red bars along the top and bottom indicate that the page has the contents of a Media
Buttons loaded into the Program (PGM) (red) and Preview (PVW) (green) Video Media Player.
This also applies to the bank buttons.

Green and red bars along the sides indicate that the page has the contents of a Media Buttons
loaded into the Program (PGM) (red) and Preview (PVW) (green) Audio Media Player. This also
applies to the bank buttons.

Tip: Right-click on the PAGE button to rename or delete the Page. Banks can also be renamed using the same method.

Organizer Mode
Organizer Mode allows you to move or copy Media Buttons between different locations on a Page, or
between different Pages, Banks, and Channel Pairs.

To Copy and Paste Media Buttons
Media Buttons can be copied or cut, and pasted using the standard Windows® clipboard or theOrganizer
Clipboard.

Note: The Organizer Clipboard is separate from the Windows® clipboard and will persist even after Organizer Clipboard is closed. Click
Clear to clear the content of the Organizer Clipboard.

1. Click Edit > Organizer Mode.

Tip: You can also right-click on a Media Button and click Organizer Mode.
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2. Select the Media Button(s) that you want to copy or move.

Tip: Hold the Ctrl button on your keyboard to select multipleMedia Buttons or hold the Shift button to select a range ofMedia Buttons.

3. Right-click on the selected Media Button(s) and click Copy or Cut.
Tip: You can also click Delete to move the Media Button(s) to the Organizer Clipboard.

4. Navigate to the Page where you want to paste the Media Buttons.
5. Right-click on the location where you want to paste the Media Buttons and click Paste.

Tip: You can paste the Media Buttons to the Organizer Clipboard to make them available for later, or you can paste Media Buttons
from multiple locations. When working with the Organizer Clipboard, note that Media Buttons that are deleted from the Page are
also added to the Organizer Clipboard.

Tip: Click to un-dock the Organizer Clipboard. Once un-docked you can move and resize the window as required. Click to
re-dock the Organizer Clipboard.

6. Click Close to return to Player Mode.

Tip: If the Organizer Clipboard is already closed, but the Organizer mode is still active (white boxes around the Media Buttons)
right-click on a Media Button and click Player Mode.

To Arrange Pages
You can move Pages between Banks on the same channel pair.
1. Click Edit > Organizer Mode.

Tip: You can also right-click on a clip and click Organizer Mode.
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2. Click Arrange Pages.

3. Drag and drop the Pages to the new location on the Banks.
4. Click Close to close the Page Arranger window.
5. Click Close to return to Player Mode.

Playlists
A Playlist allows you to collect multiple media items together into a rundown that can be presented live
on the Video Program Media Player.
A playlist can be populated with the contents of Media Buttons or by appending or inserting media items
directly from the library. When you create a playlist, you organize the media items in the order you
want them to be presented (taken), how you want to transition from one media item to the next, and
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what action you want to perform at the start and end of each media item. Media items can be added,
removed, and moved around in the playlist before or during playout.

Note: When you drag and drop a Media Button into a playlist, you are adding the contents of the Media Button to the playlist. If you edit
or delete the Media Button the media item in the playlist is not affected.

To Create a Playlist
A playlist is contained within a Media Button. Once created you can add multiple media items to the
playlist either from Media Buttons or from the library directly.
1. Right-click on the empty Media Button location you want to create a playlist for and click Create >

Playlist.

2. Enter the name for the playlist you want to create. This name is used as both the name of the Media
Button and the name of the playlist file that is created. You can change the name of the playlist later
if you want the playlist file to have a specific naming convention.

3. Click OK to create the playlist and open Playlist Editor.

Tip: Click to un-dock the Playlist Editor. Once un-docked you can move and resize the window as required. Click to re-dock
the Playlist Editor.
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4. Drag and drop Media Buttons into the Playlist Editor to add their contents to the playlist. All the
items in the playlist can be edited after the playlist is created.

Tip: You can add media items to a playlist that are not assigned to a Media Button. Refer to To Edit a Playlist on page 63 for more
information.

5. Click Save to save the current playlist.

Tip: Click Save As if you want to save the playlist as a different name.

6. Click Close to close the Playlist Editor.

To Edit a Playlist
Media items can be added, removed, and moved around in the playlist, as well as edited for what action
you want to perform at the start and end of each clip.

Tip: You can edit a playlist as it is being presented live.

1. Right-click on the Playlist Media Button that you want to edit and click Open in Editor.
Tip: You can change the name of the playlist by double-clicking on the name at the top of the Playlist Editor. The new name is applied
as soon as you move the cursor away from the name field or press enter on the keyboard. This only changes the name of the Media
Button and not the name of the playlist file. You must click Save As to change the name of the playlist file.

2. Add, move, or remove media items from the playlist as required.

Tip: Click to un-dock the Playlist Editor. Once un-docked you can move and resize the window as required. Click to re-dock
the Playlist Editor.

• Add — drag and drop a new Media Button to the location in the playlist where you want to add
the media item.

Tip: When you right-click on an item in the playlist you can also insert a media item before the selected item (Insert New Items)
or add a media item to the end of the playlist (Append New Items). This allows you to add media items to the playlist that are
not assigned to Media Buttons.
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• Move — drag a media item to a new location in the playlist.
• Remove— right-click on the media item you want to remove from the playlist and click Remove

Item(s).
Tip: When you right-click on a Media Button you can also insert a media item before the selected item (Insert New Items) or add a
media item to the end of the playlist (Append New Items). This allows you to add media items to the playlist that are not assigned to
Media Buttons.

3. Right-click on a media item in the playlist to modify the start, end, and transition attributes. Refer
to To Set the Player Settings on page 52 for information on setting the default actions that are applied
to media items when they are added to a playlist.

Tip: You can also double-click on the @Start, @End, or Transition item directly that you want to change.

• Item @START — select whether the media item starts to play automatically (PLAY) when it is
taken on the Video Program Media Player, or is paused (PAUSE).
• PAUSE — the PGM Media Player will pause as soon as the media item is taken on PGM. You

must manually play that item when it is taken on the PGM Media Player by the playlist.
• PLAY — the PGM Media Player will play the media item as soon it is taken on PGM.

• Item @END — select whether the Video Program Media Player takes the next media item in the
playlist when it reaches the end of the current media item (TAKE), pauses (PAUSE), or loops the
current media item (LOOP).
• TAKE — the PGM Media Player will take the next media item in the playlist when it reaches

the end of the current media item.
• PAUSE — the PGM Media Player will pause when it reaches the end of the media item. You

must manually play that item when it is taken on the PGM Media Player by the playlist.
• LOOP — the PGM Media Player will play the current media item again when it reaches the

end of the current media item. You must manually take the next media item in the playlist.

• ItemTransition— select how the Video Media Player transitions from Preview (PVW) to Program
(PGM). You can select a cut (CUT), or a dissolve (#.## MIX). The duration of the mix is indicated
by the duration shown in the playlist.

Note: If you want a playlist to run through all the media items in the rundown automatically, you must set each@START to PLAY and
each @END to TAKE. This sets every media item to start playing when it is taken to PGM and the Video Media Player to transition to
the next media item when it reaches the end of the current item.

Tip: Click the button in the top right of the editor to select whether the playlist stops at the end of the last media item or loops
back to the beginning of the playlist.

4. Click Save to save the current playlist.
5. Click Close to close the Playlist Editor.

To Play a Playlist
The playlist will play through the rundown of media items automatically when loaded into the PGM
Media Player.
1. Double-click on the Playlist Media Button that you want to present on the Video Media Player.
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Tip: Refer to Video Media Player on page 67 for information on using the Media Player controls.

The following actions are performed in order by the Video Media Players:
a. The first media item in the playlist is immediately cued on the Video Preview Media Player and

transitioned to the Video Program Media Player.
b. The Video Program Media Player performs the @START action for the media item and the next

media item in the playlist is cued on the Video Preview Media Player.
c. When the Video Program Media Player reaches the end of the media item it is playing it performs

the @END action. If the @END action is TAKE, the media item cued on the Video Preview Media
Player is transitioned to the Video Program Media Player according to the Transition attribute
of the current media item.

d. The Video Program Media Player performs the @START action for the new media item.

Tip: As you progress through the playlist, the media item that is currently on Program is highlighted in red and the media item that
is on Preview is highlighted in green.

2. You can cue or play a different media item in the playlist by right-clicking on the media item and
selecting an action.

• CUE Item in PVW — cue the selected media item on the Video Preview Media Player.
• CUE Start of Playlist in PVW— cue the first media item in the playlist on the Video Preview Media

Player.
• PLAY Item in PGM — play the selected media item on the Video Program Media Player.
• PLAY Start of Playlist in PGM — play the first media item in the playlist on the Video Program

Media Player.

Keep the following in mind when working with playlists:
• The bar at the top of the Video Program Media Player is purple when a playlist is active. This bar

shows the time remaining in the playlist and the item number.
• The audio slider sets the audio level for the playlist and will not change with a transition to the next

media item in the playlist.
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• If the audio player is playing out at the same time as the video player, the audio sources are summed
together.

• An audio clip in the playlist outputs black on the Video Program Media Player as the audio is playing.
You cannot play an audio clip and a video clip at the same time from the playlist. If you want to play
an audio clip at the same time as the playlist is playing you must load the audio clip into the Audio
Media Player.

• The Up and Down arrows on the keyboard adjust the audio level of the Video Media Player.
• The Left and Right arrows on the keyboard adjust the audio level of the Audio Media Player.
• You cannot move or modify a playlist item that is currently on the PGM or PVW Media Player.

Media Editor
The Media Editor allows you to edit the media item assigned to a Media Button to set, among other things,
new IN/OUT points, adjust the audio level, and set a new thumbnail.

1. Name — Change the name of the Media Button by double-clicking on the current name. The new
name is applied as soon as you move the cursor away from the name field or press enter on the
keyboard. This only changes the name of the Media Button and not the name of the media file.

2. Audio — The audio levels of all 8 audio channels in the media item as it is playing. You can adjust
the levels or mute the audio.

3. Timecode — The timecode value of the current position in the media item. An f1 or f2 at the end of
the timecode indicates Field playback (interlaced), and an f1-2 indicates Frame playback (progressive).

4. Clip Position Slider — The current point in the media item that is being played. You can drag the
handle back and forth to select a different point.

5. Transport Controls — Standard transport controls for playing the clip.
• — rewind the clip at 30-times normal speed.
• — fast forward the clip at 30-times normal speed.
• — play the clip in reverse at normal speed.
• — stop playback.
• — play the clip at normal speed.
• — jog reverse by one frame/field.
• — jog forward by one frame/field.
• — seek to the first frame in the clip.
• — seek to the last frame in the clip.

6. Play Speed — The speed that the media item is currently playing out at.
7. Loop Control — Set the media item to play normal, or repeat.
8. Thumbnail — The current thumbnail for the Media Button.
9. In Point — Set a new In Point for the media item (IN), or seek to the current In Point (GOTO IN).
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10. Out Point — Set a new Out Point for the media item (OUT), or seek to the current Out Point (GOTO
OUT).

To Edit a Media Button
1. Right-click on the Media Button you want to edit and click Open in Editor.

2. Edit the media item assigned to the Media Button as required.

Note: In and Out points are not used by the Media Editor when previewing a media item. This allows you to adjust the points while
the media item is playing in the editor.

DescriptionSetting

The In Point sets where the Video Media Player starts playing the media item. When set, you
can click GOTO IN to jump to the In Point.
a. Use the clip position slider, or transport controls, to advance themedia item to the point

where you want to media item to start.
b. Click IN to set the new In Point. A green IN is shown on the clip position slider bar.
To clear the In Point, move the slider to the start of the media item and click IN.

In Point

The Out Point sets where the Media Player stops playing the media item. When set, you can
click GOTO OUT to jump to the Out Point.
a. Use the clip position slider, or transport controls, to advance themedia item to the point

where you want to media item to end.
b. ClickOUT to set the new Out Point. A greenOUT is shown on the clip position slider bar.
To clear the Out Point, move the slider handle to the end of the media item and click OUT.

Out Point

If the media item contains audio, you can adjust the master audio level.
• Click and drag the audio slider up or down, or use the up and down arrows on the

keyboard, to adjust the level of the audio in the media item.
• Click RESET to return the audio level to the default level (0dB).
• ClickMUTE to mute the audio from the media item. TheMUTE button flashes red when

the audio is muted.

Audio Level

Change the thumbnail for the Media Button.
a. Use the clip position slider, or transport controls, to select the frame that you want to

use as the new thumbnail.
b. Click the existing thumbnail image to the right of the playout window.
The thumbnail on the Media Button is updated when you click Save in the Media Editor.

Thumbnail

3. Click Save.

Video Media Player
The Video Program and Preview Media Players present the contents of Video, Still, and Playlist Media
Buttons.
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The Video Program (PGM) and Preview (PVW) Media Players work together to present the contents of
Media Buttons with cut or mix transitions between different Media Buttons. The contents of a Media
Button can be presented individually, one item at a time, or together as a playlist that automatically
runs through the media items.
The Video PGM and PVW Media Players can play audio that is embedded in a video clip, or if an audio
clip is included in a playlist. The Video Program and Preview Media Players output black when an audio
only clip is being played.

• — Click to unload the current media item from the Media Player. If the Media Player is currently
playing a media item, the first click stops the Media Player and a second click is required to unload
the media item from the Media Player.

• — Seek to start of the media item.
• — Stop the playout of the media item.
• — Play the current media item. As the media item is playing, the timecode at the bottom of the

Media Player window shows a count-down (down arrow) or count-up (up arrow) timer. Click the
arrow to the left of the timer to change the timecode direction.

Tip: The timecode turns yellow when there are 5 seconds left in the media item and turns red at the ends. You can change the yellow
warning time value from the Player Settings.

• — The media item is plays to the end and stops, or the Media Player loops ( ) to the beginning
of the media item when it reaches the end.

Tip: You can change the loop setting while the media item is playing. This can be used to have a single media item loop a number of
times and then you can manually change the loop setting to have it play to the end.

• — Turn Electronic to Electronic (or Bypass) mode on or off. In EE mode, the video+audio signal
coming into the Media Player is routed directly to the output, bypassing the media drives.

Tip: You can place the live EE input onto the Video ProgramMedia Player by clicking TAKEwhile EE is active on the Video Preview Media
Player.

• MUTE — Mute the embedded audio from the media item.
• Audio Slider— Adjust the audio level of the media item playing on the Video Program Media Player.

If you are playing the contents of a Media Button directly, the audio level automatically adjusts to
the level saved in the Media Button when the media item is taken on the Video Program Media Player.
You can adjust the audio level manually at any time during playout.

• RESET — Reset the audio level to 0dB.
• TRANS — Set the type of transition that is used when a media item is taken from the Video Preview

Media Player to the Video Program Media Player. Click the TRANS button to set the transition to a
dissolve (MIX) or a cut (CUT). If you select a mix a popup prompts you to enter a duration.

• AUTO — Set the Video Program Media Player to automatically transition to the media item cued on
the Video Preview Media Player. When AUTO is active (green) the Video Program Media Player
automatically transitions to the media item on the Video Preview Media Player when it reaches the
end of the current clip. CUED FOR AUTO-TAKE appears across the Video Preview Media Player when
AUTO is active.
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Tip: To activate a one-time Auto-Take, click anywhere on the video on the Video Preview Media Player. CUED FOR AUTO-TAKE appears
across the Video Preview Media Player.

• TAKE — Manually initiate a transition of the clip on the Video Preview Media Player to the Video
Program Media Player. The type and duration of the transition is set by the TRANS setting.

Tip: You can place the live EE input onto the Video Preview Media Player by clicking TAKE while EE is active on the Video Preview Media
Player.

To Play Media in the Video Media Player
Still and Video Media Buttons can be loaded and played on the Video Program and Preview Media
Players. Each Media Player has dedicated HD-BNC video and key (alpha) outputs with 8 tracks of
embedded audio.

Tip: Media Player audio can be sent to the AES-59/TASCAM® audio output from the Audio Router.

1. Click the Video or Still Media Button you want to load onto the Video Preview Media Player.

Tip: Double-click a Media Button to load it onto the Video Preview Media Player and immediately take it on the Video Program Media
Player.

Tip: You can also drag and drop a Media Button onto the Media Player.

A green box appears around the video on the Video Preview Media Player and the Media Button.

2. Click TAKE to transition the media item on the Video Preview Media Player to Video Program Media
Player.

Note: The VIDEOPGMPlayer@START of CLIP parameter in thePlayer Settingsmust be set toPLAY for themedia item to automatically
play when taken on the Video Program Media Player.

3. Click the next Media Button that you want to play after the end of the current media item. The
contents of Media Button is cued on the Video Preview Media Player.

4. Click AUTO to set the Media Player to automatically transition the media item on the Video Preview
Media Player to the Video Program Media Player when it reaches the end of the media item it is
currently playing.
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Tip: You can click anywhere on the video image in the Video Preview Media Player to perform a one-time Auto transition. CUED FOR
AUTO-TAKE appears across the Video Preview Media Player. Unlike clicking the AUTO button, you don't have to toggle this off after
the transition. It is only applied to that media item.

Tip: You can click TRANS to change the type of transition used or the length of the mix transition.

Tip: You can click TAKE to perform the transition immediately, before the media item on the Video Program Media Player has ended.

5. Add the contents of another Media Button to the Video Preview Media Player or allow the media
item on the Video Program Media Player to end.

Note: The VIDEO PGM Player @END of CLIP parameter in the Player Settings sets whether the Video Program Media Player cuts
to black or freezes the video on the last frame when it reached the end of the media item.

Audio Player
The Audio Program and Preview Media Players present the contents of Audio Media Buttons.
The Audio Program and Preview Media Players work together to present the contents of audio Media
Buttons with transitions between the media items. Audio Media Buttons can only be presented
individually, one item at a time, from the Audio Media Player.

• — Click to unload the current media items from both the Audio Program and Preview Media
Players. If the Audio Media Player is currently playing a media item, the first click stops the Media
Players and a second click is required to unload the media item. You cannot unload the Audio Preview
Media Player if a media item is not loaded into the Audio Program Media Player.
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• — Seek to start of the media item.
• — Stop the playout of the media item.
• — Play the current media item. As the media item is playing, the timecode at the bottom of the

window shows a count-down (down arrow) or count-up (up arrow) timer. Click the arrow to the left
of the timer to change the timecode direction.

Tip: The timecode turns yellow when there are 5 seconds left in the media item and turns red when the media item ends. You can
change the yellow warning time value from the Player Settings.

• — The media item is played to the end and stops, or the Media Player loops ( ) to the beginning
of the media item when it reaches the end.

Tip: You can change the loop setting while the media item is playing. This can be used to have a single media item loop a number of
times and then you can manually change the loop setting to have the media item play to the end.

• MUTE — Mute the media item.
• Audio Slider— Adjust the audio level of the media item playing on the Audio Program Media Player.
• RESET — Reset the audio level to 0dB.
• AUTO — Set the Audio Program Media Player to automatically transition to the media item cued on

the Audio Preview Media Player. When AUTO is active (green) the Audio Program Media Player
automatically transitions to the media time on the Audio Preview Media Player when it reaches the
end of the current clip. CUED FOR AUTO-TAKE appears across the Audio Preview Media Player when
AUTO is active.

Tip: To activate a one-time Auto-Take, click anywhere on the video on the Audio Preview Media Player. CUED FOR AUTO-TAKE appears
across the Audio Preview Media Player.

• TAKE — Manually initiate a transition of the clip on the Audio Preview Media Player to the Audio
Program Media Player.

To Play Audio in the Audio Media Player
Audio tracks from the Audio Media Player are added (digitally summed) to the tracks in the Video Media
Player. The combined audio tracks are embedded in the Video PGM Media Player video stream.
1. Click the Audio Media Button you want to load into the Audio PVW Media Player.

Tip: Double-click an Audio Media Button to load it into the Audio PVW Media Player and immediately take it to the Audio PGM Media
Player.

Tip: You can also drag and drop a Media Button onto the Audio Media Player.

A green box appears around the icon of the audio clip in the Audio PVW Media Player and the Media
Button.

2. Click TAKE to transition the media item in the Audio PVW Media Player to PGM.

Note: The AUDIO PGM Player @START of CLIP parameter in the Player Settingsmust be set to PLAY for the clip to automatically
play when taken onto the Audio PGM Media Player.

3. Click on the next Audio Media Button that you want to play after the end of the current clip. The
contents of the Media Button is cued in the Audio PVW Media Player.
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4. Click AUTO to set the Audio Media Player to automatically transition from the PGM to PVW Media
Button when the PGM Media Player reaches the end of the clip it is currently playing.

Tip: You can click anywhere on the Media Button thumbnail in the Audio PVW Media Player to perform a one-time Auto transition.
CUED FOR AUTO-TAKE appears across the PVW Media Player. Unlike clicking the AUTO button, you don't have to toggle this off after
the transition. It is only applied to that clip.

Tip: You can click TAKE to perform the transition immediately.

5. Load another Media Button onto the Audio PVW Media Player or allow the clip in the PGM Media
Player to end.

Recording
Each channel pair has a single HD-BNC record input (video+audio) that is tied to the PVW Video Media
Player for that channel pair.

To Record to a Media Button
The video input (video+audio) for the channel pair can be recorded as video with audio (Video Media
Button), audio only (Audio Media Button), or as a still image (Still Media Button).
1. Right-click on the empty Media Button that you want to record to.
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2. Select Record and click on the type of media you want to record. The type of media sets the type of
Media Button you are creating.
• Video — a Video Media Button containing video with or without audio.
• Audio — an Audio Media Button containing audio without video.
• Still — a Still Media Button containing a still image without audio.

3. Select the track and clip information you want to record.

DescriptionSetting

• Video— record the video track.
• Audio— record the audio tracks.

Track Info

• Name— enter a name for the media file. The name is also applied to the Media Button
but can be changed later.

• Suffix— automatically add a sequential number (Numeric) or the current time of day
(Time of Day) to the end of the name.

• Timecode— the timecode for the clip can start at zero (Striped) or use the external
timecode input (External LTC).

Note: The External LTC setting uses LTC or ATC, depending on how the timecode is configured
for the channel pair.

Clip Info

4. Click OK. The Video Preview Media Player goes into EE mode and the Media Recorder opens.
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5. Click Record ( ) to start recording.

6. When you are ready to finish recording, click Stop ( ).

7. Trim the IN and OUT points of the clip and adjust the audio level as required.

Tip: Click on the thumbnail image to generate a new thumbnail from the current frame of video.

8. Click Save to save the new media item to the Media Button.
9. Click Close.
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Maintenance
Refer to the following information for performing maintenance on your server, muting an alarm,
restoring factory defaults, or upgrading the software.

Media Drives
The server uses a RAID array of media drives to store all media content.

Disk Space
The amount of free disk space that is available for media items is shown at the bottom of the Kiva
Presenter window. The free space is shown in timecode format (HH:MM:SS:FF) and percentage of free
space on the drive. When the amount of free space goes below 10% the text is highlighted in yellow. If
the amount of free disk space goes below 5% the text is highlighted in red.

Tip: When the amount of free disk space goes below 5% you should consider removing unused content in order to free-upmedia disk space.
Use Windows® Explorer to removed unused media.
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AsRun Log Creator
The server keeps a log of stills and clips that have been played in their entirety on all channel of the
server. This information can then be filtered and output into either a CSV file or a PDF report.

Note: Clips must be played out in their entirety to be added to the AsRun log.

The AsRun log can be filtered for a number of criteria for the media items and when or where they were
played.
• Date Range — the range of dates that the media items was played in.
• Channels — the transport channels that the media items were played on.
• Media Players — the type of media item that was played (audio and video).
• Media File Name — the name of the media item that was played.

To Run an AsRun Report
Generate a PDF or CSV report of what clips and stills were played on the server.
1. Launch the AsRunReport application on your server.

2. Set the parameters and filters you want to apply to the report

DescriptionItem

This is the name that appears on the report.Report Name

Add any additional notes that you want to appear on the report.Additional Notes

Select how you want the report to be formatted.
• Aggregate— lists how many times each clip was played during the selected date range
• Individual— lists every instance that a clip was played, including the start and stop times,

during the selected date range

Format

Set the from and to date range between which you want to generate the report.Date Range

Select which transport channels on the server that you want to generate the report for.
Channel that are not present on your server are grayed out.

Channels

Select whether you want to show only audio clips, only video clips, or both.Media Players
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DescriptionItem

Enter a name or part of a name in the field, or leave the field blank. The clips that were played
during the date range will be filter to only include those clip names that include theMedia
File Name. If no name is specified the filter will return all clip names.

Media File Name

3. Click Apply Filter.
The table below lists all the results of the filter.

Tip: You can change the filter settings and click Apply Filter again to update the search results.

4. Click a Create button to generate the report file. You are prompted for a location to save the file.
• Create CSV — creates a standard comma segmented value (CSV) file.
• Create PDF — creates a formatted PDF report file.

5. Click Exit.
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Troubleshooting
Refer to the applicable section below for information on troubleshooting the operation or setup of your
server.

Kiva Import Problems
• Cannot see any remote directories when choosing the Import From directory, or when selecting clips

to import.
• Have you mapped the remote directory as a local disk drive?

• Importing 720p MOV files result in 1080 clips (or vice versa).
• The importer converts all MOV files into the current video format that the server is operating in.

For example, if the server is set to the 1080i 59.94, then all imported clips are converted to 1080i
59.94.

• If you want to import 720p MOV files as 720p clips, you must change the video format of the server
to 720p before importing these MOV files.

General Problems
• Video output is not synchronized with downstream devices.

• Check that a reference signal is connected to the Reference BNC on the back of the server and that
the correct reference format is selected.

• I cannot record external timecode.
• Check that a valid analog timecode signal is connected to the LTC IN port.
• Verify that the timecode signal is 1V peak-to-peak minimum.

• I hear a beeping sound from inside the main server chassis.
• Check to see if two power cords are connected to the AC input on both power supplies. If only one

power cord is connected, then the internal alarm will sound. The only way to silence the alarm is
to either connect AC power to both modules, or remove the module without power. Although the
server can operate with just one power module, it is not recommended.

• If the two power cords are connected to the two modules of the power supply, and you are sure
there is full power on both power cords, then check the small LED on each of the two power supply
modules (from the chassis rear). These LEDs should be solid green. If either LED is blinking, or
has changed to yellow or red, then you may have a fault in the power supply module. Remove the
suspect power supply module immediately (the alarm should then mute). Contact Ross® technical
support for assistance.

• If the power supply checks okay, check the LEDs on the media drives on the front of the server.
These LEDs should be BLUE or PURPLE. If any of the LEDs are RED there may be a failed media
drive. Eject the drive and re-seat the dive in the bay. If this does not clear the fault after 5-10
seconds the drive may have failed. Contact Ross® technical support for assistance.

• How do I record more than just two channels of audio?
• The Server comes standard with 14-channel embedded audio per video channel. To record more

than 2-channel audio, you must enable the selection in Kiva Config application.
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Specifications
Resources, video specifications, power rating, and port pinouts.
The information is this section is subject to change without notice.

Resources
The number of resources specific to your server depends on the model.

2 Video Board1 Video BoardResource

21Video Inputs

84Video Outputs

168AES Audio Inputs

168AES Audio Outputs

21Analog Audio Outputs

Operating Temperature
The system has been qualified at an operational temperature range of 13 to 35°C (55 to 95°F) and a
non-condensing humidity range of 20 to 80%.

Table 2: Safe Operation and Non-operating Environmental Conditions

Non-operatingOperating

-40 to 65°C (-40 to 149°F)5 to 55°C (41 to 131°F)Temperature

5 to 95% non-condensing8 to 90% non-condensingRelative Humidity

35°C (95°F) non-condensing29.5°C (85°F) non-condensingMax. Wet Bulb Temperature

15°C/hour (59°F/hour)15°C/hour (59°F/hour)Max. Temperature Gradient

-300 to 12,200m (-984 to 40,026ft.)-300 to 3,048m (-984 to 10,000ft.)Altitude Range

Note: Operator is responsible for providing sufficient ventilation to maintain surface temperature below 40°C (104°F) at the center of the
top cover of the Kiva chassis.

Note: Non-condensing conditions should be maintained at all times.

Note: Maximum storage period inside shipping package is one year.
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Ports
Serial (RS422) Port

The female DB9 serial connectors on theRS422Control BreakoutCable support the RS-422 transmission
standard.

SignalPin

Ground1

Tx-2

Rx+3

Rx-Ground4

n/c5

Tx-Ground6

Tx+7

Rx-8

n/c9

LTC (3-Pin XLR) Port
The EIA Standard RS-297-A describes the use of the XLR3 for balanced audio signal applications.

SignalPin

Ground (cable shield)1

LTC+ / Positive ( “ hot ” )2

LTC- / Negative ( “ cold ” )3

AES Audio (DB25) Port
There are two AES audio ports on the back of the server providing 8-track AES inputs and outputs. Each
AES input and output can be assigned to an available video channel using the internal Audio Router
(refer to Audio Router Setup on page 15). Both ports have the same pinouts.
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Settings (continued)
Timecode Display 52

Setup 12
Shortcut Keys 54
Specifications 79

T
Thumbnail 53
Timecode 17
Timecode Display 52
TSL Tallies 20

V
Video Format 12
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